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Introduction


About

StaxRip is a video encoding GUI for Windows, it executes and controls console apps like x265, mkvmerge and ffmpeg and uses the scripting based frame servers AviSynth and VapourSynth for video processing.


Feature Highlights


	Support for a wide variety of formats and tools


	All popular and modern video encoders like x265 and nvenc are supported


	Hardware encoding for AMD, Intel and NVIDIA


	Batch Processing


	Video editing using AviSynth and VapourSynth, direct control of the script and popular filters like QTGMC included


	Scriptable via PowerShell


	Minimal user interaction required due to rich configuration and automation features


	Copy modes for audio and video for plain remuxing


	Cut/Trim feature, for MKV output no re-encoding is required


	High DPI scaling


	Portable, nothing has to be installed


	Parallel Job processing, parallel audio video processing, parallel junk encoding for x265









Download


Stable

https://github.com/staxrip/staxrip/releases




Beta

DropBox [https://www.dropbox.com/sh/4ctl2y928xkak4f/AAADEZj_hFpGQaNOdd3yqcAHa?dl=0]

OneDrive [https://1drv.ms/u/s!ArwKS_ZUR01g0kH4d4eT_6a3GaKe?e=qbOfGS]






Setup

It’s important to understand that x64 and x86 can never be mixed, everything StaxRip requires and everything it uses is x64, x86 plugins generally don’t work in x64 applications.

Windows 7 x64 is the minimum required Windows version.

.NET Framework [https://www.microsoft.com/net/download/dotnet-framework-runtime] is required in verrsion 4.8.

Another requirement is Visual C++ 2019 x64 [https://support.microsoft.com/en-gb/help/2977003/the-latest-supported-visual-c-downloads] with minimum version 14.25.28508

StaxRip has portable versions of AviSynth, VapourSynth and Python included, a setup is not required.

Hardware encoding works only on newer hardware and up to date drivers.

It’s not possible to start StaxRip from a location without full write access.







          

      

      

    

  

    
      
          
            
  
Screenshots
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Features

StaxRip is the oldest (since 2002), most feature rich and flexible encoding GUI.


General


	Support for a wide variety of formats and tools.


	Batch Processing, can not only be used for encoding but for any task like remuxing,
demuxing or AviSynth/VapourSynth script generation.


	Cut/Trim feature, for MKV output it works even in Copy/Mux mode, no re-encoding required.


	Minimal user interaction required due to rich configuration and automation features.


	Macro system to be used in scripts and command lines, this enables a design that allows
to change any setting at any time which is much more flexible and powerfull than a design
that requires to perform one step after another.


	The job list can be processed with multiple StaxRip instances in parallel for maximum
performance using modern CPUs.


	Video and multiple audio tracks can be processed in parallel for maximum performance with modern hardware.


	Support for an unlimited amount of audio and subtitle tracks.


	Automatic and manual update check.


	Powerfull media info using the worlds best media info frontend MediaInfo.NET
which includes a folder view to show media info for a folder in a grid view.


	Powerfull media preview using the worlds best media player mpv(.net).


	Support via forum and issue tracker.


	Easy to use and feature rich crop dialog with hardware acceleration.


	Auto crop.


	Powerfull resize and aspect ratio related features with auto detection.


	Thumbnail generation tools.


	Full access and control to underlying tools with full support for
command line and script editing to leverage the full potential of the tools.


	Container and hardcoded subtitles.


	Clean and easy to read log file and dedicated log file viewer to easily navigate the processing steps.


	Video comparison tool to compare video frames in a tab view.


	The processing window can be minimized to the system tray.


	For all essential console tools such as x265 and mkvmerge there is a built-in command line preview
either directly integrated in the dialog or via menu showable.







Tool Management


	Powerfull tool management dialog.


	200 tools included.


	Tools are searchable.


	Custom paths can be defined or removed.


	Custom paths can be defined using the powerfull search and index tool voidtools Everything.


	Tool overview either as CSV file opened in (MS) Office or using PowerShell Out-GridView
which supports a powerfull search and filter feature.


	Feature to open the folder of a tool or start the tool including console tools showing the help.







Help


	For every tool the help file or help page can be shown in the Apps management dialog and also in the main menu under Help.


	The Apps management dialog provides easy access to tool websites and download sites.


	Tooltips.


	Context help via right-click, for x264 and x265 the context help has a local and a online version,
for all video encoders the console output help can be shown via context help and with console look and feel.


	Customizable assistant.







Preprocessing


	Preprocessing steps such as demuxing is fully customizable with custom command lines.


	Demuxers: mkvextract, MP4Box, ffmpeg, eac3to.


	Demuxing GUI for mkvextract, MP4Box, ffmpeg and eac3to to define which tracks should be demuxed.


	Automatic demuxing mode to automatically demux everything.


	Automatic indexing with DGIndex, DGIndexNV, ffms2 and L-Smash-Works.







Projects, Templates, Profiles


	AviSynth and VapourSynth video filter plugins that are not included can be used by adding custom filter profiles.


	Customizable video filter profiles that can be enabled via context menu.


	Project system that automatically saves encoding settings for a particular source file.


	Previously encoded projects can be found in a Recent menu to encode them again
with different settings, encoded audio and video of previous runs can be reused or overwritten.


	Project templates for different types of sources, a startup template can be defined to customaize the startup settings.


	Profile system for video filter profiles, video encoder profiles, audio encoding profiles,
muxing profiles, filter setup (full script) profiles.


	Project options used by projects and project templates and also separate global settings.







Video Processing


	Video editing using classic AviSynth and next generation VapourSynth, both equally well supported
and everything like QTGMC just works out of the box effortlessly.


	Large amount of included AviSynth and VapourSynth plugins, overall 200 tools incuded.


	Code editor to enable full control over AviSynth and VapourSynth,
everything that is possible with AviSynth and VapourSynth is also possible with StaxRip.


	Code preview to preview the code generated for AviSynth and VapourSynth.


	Built-in hardware accelerated video preview and preview via mpv(.net) and MPC-BE/MPC-HC.


	Built-in script info to show script parameters like framerate and
advanced script preview using various external tools like AVSMeter.


	External AviSynth (.avs) and VapourSynth (.vpy) scripts can be opened/imported.


	Automatic import of (VUI) color metadata.


	Full high bit depth and HDR support.


	Compressibility check.


	It can be customized which source filters should be used for different formats.


	Unicode support for AviSynth on Windows 10.







Encoding


	Hardware encoding for AMD, Intel and NVIDIA.


	All classic and modern video encoders are fully supported: XviD, x264, x265, Rav1e, SVT-AV1, NVEnc, QSVEnc, VCEEnv, ffmpeg.


	Audio encoders: eac3to, qaac, fdkaac, ffmpeg.


	Popular encoders such as x265 and NVEnc have almost 100% GUI support
meaning allmost all available command line switches are supported.


	Video encoder dialogs are searchable to quickly find options in a drop down and search field.


	Video encoder dialogs have a command line preview, this preview has a context
menu that allows to quickly find GUI options for command line switches.


	Generic audio and video command line based encoder to integrate any encoder that isn’t already built-in.


	Parallel audio video encoding.


	Parallel junk encoding for x265.







Muxing


	MKV output using mkvmerge.


	MP4 output using MP4Box.


	ffmpeg supporting various container formats.


	Copy/Mux modes for audio and video plain re-muxing without encoding.


	Cut/Trim feature for MKV output that works even in Copy/Mux mode, no re-encoding required.







Power User


	Event Command feature that allows to assign custom commands to various events
for instance to execute custom command lines on given events.


	Scriptable via PowerShell.


	Customizable main menu and context menus.


	Long path support, if enabled in Windows 10 file paths can be longer than 260 characters.


	A PowerShel terminal can be shown with support for the new Windows Terminal,
this terminal has a special environment for easy access of included console
tools, all macros are available as environment variables in this
terminal and in all features that allow to define custom command lines.







Installation


	100% Portable, nothing has to be installed.


	Installed AviSynth or VapourSynth can optionally be used instead of the included.







User Interface


	Pixel perfect High DPI scaling.


	Large amount of customized GUI controls and elements.
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Preprocessing


Demuxing

StaxRip supports demuxing via MP4Box, mkvextrakt, ffmpeg, eac3to and DGMPGDec.

Supported are three different demuxing modes:


	Everything is demuxed automatically.


	Only audio and subtitle streams of preferred languages are automatically demuxed.


	A dialog is shown where users can select which audio and subtitle streams should be demuxed.





	The demuxing mode can be defined in the project options under

	the Audio and Subtitles tab.





When demuxing is disabled StaxRip will still find and include audio and
subtitle tracks directly from the source file using a demux free mode,
to prevent this the Preferred Languages option has to be cleared.

Custom preprocessing tools for demuxing, re-muxing or indexing can be
integrated and configured via command line to either execute a preprocessing
tool like a demuxer directly or with a scripting tool like PowerShell or Python.
When a preprocessing command line executes, all console tools are added to the
path environment variable and all macros are available as environment variables.
Preprocessing can be customized in the Settings dialog under Preprocessing.






Video Processing

Video processing is supported via AviSynth and VapourSynth,
both being equally well supported.

The script code of AviSynth and VapourSynth can be edited directly or
easily be generated via menu selection for which a profile system is
available to integrate and customize custom filters and plugins.

With the help of a macro system script parameters can be changed with
convenient GUI features like a resize slider and menu or a cropping dialog,
due to the macro system the parameters can change at any time allowing much
greater flexibility compared to a one dimensional and limiting one step after
another approach.


Filter Profiles

StaxRip includes a large set of filter plugins and filter presets for the plugins.
The presets can be selected in the filter menu.


Custom Filter Profiles

The filter profiles editor can be used to customize the included
filter profiles and to create new custom filter profiles.

The profile editor can be found at:

Filter Menu > Profiles

The filter profiles use the INI format:

[Filter Type]

Menu item name = Filter code





Cascading/sub menus:

Top level | Level 2 | Level 3 = Filter code





Multi-line code:

Menu name =
    code line 1
    code line 2





Many of the included presets use Interactive Macros to show a selection box.

Example:

[Field]

yadifmod2 =
    LoadPlugin("D:\yadifmod2\yadifmod2.dll")
    yadifmod2()










Opening scripts externally

Opening AviSynth and VapourSynth scripts with external apps
from outside of StaxRip might require adding various directories
to the PATH environment variable.

The Apps dialog has a feature that helps adding the directories:

Apps > Manage > Tools > Path Env Var

Consider adding the following directories to PATH:

Apps\FrameServer\AviSynth

Apps\FrameServer\VapourSynth

Legacy apps like VirtualDub2 or MPC player are VFW based and therefore
require AviSynth/VapourSynth being installed. For modern apps like mpv.net
it’s sufficient to add the portable AviSynth/VapourSynth folder to PATH.

Apps\Support\VC

This is a VC++ runtime All-in-One package which many apps, libraries
and plugins depend on.

Apps\Support\FFTW

This a library which many AviSynth and VapourSynth plugins depend on.






Templates

StaxRip uses a template system, technically a template is a empty project file.
When StaxRip starts it loads a default template, this default template can be changed at:

Main Menu > Tools > Settings > General > Startup Template

Project options are saved in templates/projects while Tools > Settings are global settings.

A template can be saved using:

Main Menu > File > Save Project As Template




Video Encoding

Supported encoders are:


	xvid


	x264


	x265


	nvenc


	qsvenc


	vceenc


	rav1e


	SVT-AV1


	ffmpeg







Parallel Processing


Job Processing

The jobs list can be processed with multiple StaxRip instances in parallel.
This feature is only recommended for power users that know exactly what their
hardware is capable of.




Chunk Encoding

StaxRip supports chunk encoding for the x265 encoder, it splits the encoding
into chunks and encodes the chunks in parallel. Only recommended for power users
that know exactly what their hardware is capable of. This feature can be configured at:

x265 dialog > Input/Output > Chunks

Main Menu > Tools > Settings > General > Maximum number of parallel processes






Batch Processing

For Batch Processing first wanted options have to be changed, after that files can be added at:

File > Open Video File > File Batch

Not only encoding is supported but any task like remuxing, demuxing or
AviSynth/VapourSynth script generation, this can be achieved by disabling
unwanted features, almost every feature can be disabled:


	The video encoder profiles have a Copy/Mux profile.


	The muxer profiles have a No Muxing profile.


	The audio profiles have a Copy/Mux and a No Audio profile.


	Indexing can be disabled by installing LAV Filters and by enabling the DSS2 source filter.


	Audio and subtitle demuxing can be disabled in the Options dialog.







Command Engine

StaxRip uses a command engine for the following features:


	StaxRips command line interface


	StaxRips configurable main menu and various other menus


	StaxRips Event Command Feature (Main Menu > Tools > Advanced > Event Commands)




The Event Command feature allows to run commands on defined events under defined conditions.







          

      

      

    

  

    
      
          
            
  
Support

For bug reports, feature requests and usage questions please use the Issue Tracker [https://github.com/staxrip/staxrip/issues] but before making a bug report please try the newest Beta version.

Alternativly the StaxRip thread [https://forum.videohelp.com/threads/369913-StaxRip-support-thread] of the VideoHelp forum can be used.


User Chat

https://discord.gg/rRn7vGU







          

      

      

    

  

    
      
          
            
  
Commands

Commands can be used in:


	Main Menu


	Event Command


	Command Line Interface





Main Menu

The main menu can be customized at:

Main Menu > Tools > Edit Menu.




Event Command

The Event Command feature allows to define a command to be executed on a defined event under defined conditions.

Find it at:

Main Menu > Tools > Advanced > Event Command




Available Commands


	
AddBatchJob

	Adds a batch job.







	sourcefile <string>







	
AddFilter

	Adds a filter at the end of the script.







	active <boolean>



	name <string>



	category <string>



	script <string>







	
AddJob

	Adds a job to the job list.







	showConfirmation <boolean>

	Show Confirmation



	templateName <string>

	Template Name: Name of the template to be loaded after the job was added. Empty to load no template.



	position <integer>

	Position to insert new job







	
AddTags

	Adds tags to the container (works only with mkvmerge).







	tags <string>

	name 1 = value 1; name 2 = value 2; etc.







	
CheckForUpdate

	Checks if a update is available.






	
ClearJobs

	Clears the job list.






	
CopyToClipboard

	Copies a string to the clipboard.







	value <string>

	Copies text to the clipboard. May contain macros.







	
DeleteFiles

	Deletes files in a given directory.







	dir <string>

	Directory: Directory in which to delete files.



	filter <string>

	Example: ‘.txt .log’







	
DynamicMenuItem

	Placeholder for dynamically updated menu items.







	id <dynamicmenuitemid>

	Audio1Profiles, Audio2Profiles, EncoderProfiles, FilterSetupProfiles, MuxerProfiles, RecentProjects, TemplateProjects, HelpApplications, Scripts, AddFilters, InsertFilters, ReplaceFilters, FilterCategory







	
ExecuteCommandLine

	Executes a command line. If Shell Execute is disabled then macros are passed in as environment variables.







	commandLine <string>

	Command Line: The command line to be executed. Macros are solved.



	waitForExit <boolean>

	Wait For Exit: Halt until the command line returns.



	showProcessWindow <boolean>

	Show Process Window: Redirects the output of console apps to StaxRips process window. Disables Shell Execute.



	useShellExecute <boolean>

	Use Shell Execute: Executes the command line using the shell. Available when the Show Process Window option is disabled.



	workingDirectory <string>

	Working Directory: Working directory the process will use.







	
ExecutePowerShellScript

	Executes PowerShell script code.







	code <string>

	Script Code: PowerShell script code to be executed. Macros are expanded.



	externalShell <boolean>

	Use External Shell: Execute in StaxRip to automate StaxRip or use external shell.







	
ExecuteScriptFile

	Executes a PowerShell PS1 script file.







	filepath <string>

	File Path: Filepath to a PowerShell PS1 script file. May contain macros.







	
Exit

	Exits StaxRip






	
GenerateWikiPages

	Generates various wiki pages.






	
ImportVideoEncoderCommandLine

	Changes video encoder settings.







	commandLine <string>

	Command Line







	
LoadProfile

	Loads a audio or video profile.







	videoProfile <string>

	Video



	audioProfile1 <string>

	Audio 1



	audioProfile2 <string>

	Audio 2







	
LoadSourceFile

	Loads a source file.







	path <string>

	Source File Path







	
LoadTemplate

	Loads a template.







	name <string>







	
OpenHelpTopic

	Opens a given help topic In the help browser.







	topic <string>

	Help Topic: Name Of the help topic To be opened.







	
PlaySound

	Plays audio file.







	FilePath <string>

	Filepath to a mp3, wav or wmv sound file.



	Volume <integer>

	Volume (%)







	
ResetSettings

	Shows a dialog allowing to reset specific settings.






	
SaveGIF

	Shows a Open File dialog to generate a short GIF.






	
SaveMKVHDR

	Shows a Open File dialog to add the remaining HDR10 Metadata to a MKV file.






	
SaveMTN

	Shows a Open File dialog to generate thumbnails using mtn engine






	
SavePNG

	Shows a open file dialog to create a high quality PNG animation.






	
SaveProject

	Saves the current project.






	
SaveProjectAs

	Saves the current project.






	
SaveProjectAsTemplate

	Saves the current project as template.






	
SaveProjectPath

	Saves the current project at the specified path.







	path <string>

	The path may contain macros.







	
SetBitrate

	Sets the target video bitrate in Kbps.







	bitrate <integer>

	Target Video Bitrate







	
SetFilter

	Sets a filter replacing a existing filter of same category.







	name <string>



	category <string>



	script <string>







	
SetHideDialogsOption

	Sets the project option ‘Hide dialogs asking to demux, source filter etc.’







	hide <boolean>







	
SetPercent

	Sets the bitrate according to the compressibility.







	value <integer>

	Percent Value







	
SetSize

	Sets the target file size in MB.







	targetSize <integer>

	Target File Size







	
SetTargetFile

	Sets the file path of the target file.







	path <string>

	Target File Path







	
SetTargetImageSize

	Sets the target image size.







	width <integer>



	height <integer>







	
SetTargetImageSizeByPixel

	Sets the target image size by pixels (width x height).







	pixel <integer>







	
ShowAppsDialog

	Dialog to manage external tools.






	
ShowAudioProfilesDialog

	Dialog to manage audio profiles.







	number <integer>

	Track Number (0 or 1)







	
ShowBatchGenerateThumbnailsDialog

	Shows a dialog to generate thumbnails.






	
ShowCodePreview

	Dialog to preview script code.






	
ShowCropDialog

	Shows the crop dialog to crop borders.






	
ShowDemuxTool

	Allows to use StaxRip’s demuxing GUIs independently.






	
ShowEncoderProfilesDialog

	Shows a dialog to manage video encoder profiles.






	
ShowEventCommandsDialog

	Shows the Event Command dialog.






	
ShowFileBrowserToOpenProject

	Shows a file browser to open a project file.






	
ShowFilterProfilesDialog

	Dialog to configure filter profiles.






	
ShowFiltersEditor

	Dialog to edit filters.






	
ShowFilterSetupProfilesDialog

	Dialog to configure filter setup profiles.






	
ShowHardcodedSubtitleDialog

	Shows a dialog to add a hardcoded subtitle.






	
ShowJobsDialog

	Dialog to manage batch jobs.






	
ShowLogFile

	Shows the log file with the built-in log file viewer.






	
ShowMacrosDialog

	Dialog that shows available macros.






	
ShowMainMenuEditor

	Dialog to configure the main menu.






	
ShowMediaInfo

	Shows media info on a given file.







	filepath <string>

	May contain macros.







	
ShowMediaInfoBrowse

	Shows a Open File dialog to show media info.






	
ShowMediaInfoFolderViewDialog

	Presents MediaInfo of all files in a folder in a grid view.






	
ShowMessageBox

	Shows a message box.







	mainInstruction <string>

	Main Instruction: Main instruction may contain macros.



	content <string>

	May contain macros.



	icon <msgicon>

	None, Error, Question, Warning, Info







	
ShowMkvInfo

	Shows a Open File dialog to open a file to be shown by the console tool mkvinfo.






	
ShowMuxerProfilesDialog

	Dialog to manage Muxer profiles.






	
ShowOpenSourceBatchFilesDialog

	Dialog to open a file batch source.






	
ShowOpenSourceBlurayFolderDialog

	Dialog to open a Blu-ray folder source.






	
ShowOpenSourceDialog

	Dialog to open source files.






	
ShowOpenSourceMergeFilesDialog

	Dialog to open a merged files source.






	
ShowOpenSourceSingleFileDialog

	Dialog to open a single file source.






	
ShowOptionsDialog

	Dialog to configure project options.






	
ShowPreview

	Dialog to preview or cut the video.






	
ShowScriptInfo

	Shows script info using various console tools.






	
ShowSettingsDialog

	Shows the settings dialog.






	
ShowSizeMenuEditor

	Menu editor for the size menu.






	
ShowVideoComparison

	Shows a dialog to compare different videos.






	
Shutdown

	Shut down PC.






	
Standby

	Standby PC.






	
StartAutoCrop

	Crops borders automatically.






	
StartCompCheck

	Starts the compressibility check.






	
StartEncoding

	Creates a job and runs the job list.






	
StartJobs

	Runs all active jobs of the job list.






	
StartSmartCrop

	Crops borders automatically until the proper aspect ratio is found.






	
StartTool

	Starts a tool by name as shown in the app manage dialog.







	name <string>

	Tool Name: Tool name as shown in the app manage dialog.







	
TestAndDynamicFileCreation

	Development tests and creation of doc files.






	
WriteLog

	Writes a log message to the log file.







	header <string>

	Header is optional and may contain macros.



	message <string>

	Message is optional and may contain macros.












          

      

      

    

  

    
      
          
            
  
Macros

Macros are placeholders that can be used in all locations where StaxRip allows to customize command lines and scripts.

Whenever StaxRip starts a process and shell execute is disabled it passes all macros as environment variables to the process.


Interactive Macros

Interactive macros can be used in certain menus like the filter profiles menu.



	Name

	Description





	$browse_file$

	Filepath returned from a file browser.



	$enter_text$

	Text entered in a input box.



	$enter_text:prompt$

	Text entered in a input box.



	$select:param1;param2;…$

	String selected from dropdown, to show a optional message the first parameter has to start with msg: and to give the items optional captions use caption|value. Example: $select:msg:hello;caption1|value1;caption2|value2$









Command Line Audio Encoder

StaxRip supports 2 types of audio encoding profiles, a GUI based profile used for the default audio profiles and a Command Line based profile which supports following macros:







	Name

	Description





	%input%

	Audio source file



	%output%

	Audio target File



	%bitrate%

	Audio bitrate



	%delay%

	Audio delay



	%channels%

	Audio channels count



	%language_native%

	Native language name



	%language_english%

	English language name









Global Macros



	Name

	Description





	%app:name%

	Returns the path of a given tool, it can be any type of tool found in the Apps dialog. Example: %app:x265%



	%app_dir:name%

	Returns the directory of a given tool, it can be any type of tool found in the Apps dialog. Example: %app_dir:x265%



	%app_path:name%

	Returns the path of a given tool, it can be any type of tool found in the Apps dialog. Example: %app:x265%



	%app_version:name%

	Returns the version of a given tool, it can be any type of tool found in the Apps dialog. Example: %version:x265%



	%audio_bitrate%

	Overall audio bitrate.



	%audio_file1%

	File path of the first audio file.



	%audio_file2%

	File path of the second audio file.



	%compressibility%

	Compressibility value.



	%crop_bottom%

	Bottom crop value.



	%crop_height%

	Crop height.



	%crop_left%

	Left crop value.



	%crop_right%

	Right crop value.



	%crop_top%

	Top crop value.



	%crop_width%

	Crop width.



	%delay%

	Audio delay of the first audio track.



	%delay2%

	Audio delay of the second audio track.



	%dpi%

	DPI value of the main dialog.



	%encoder_ext%

	File extension of the format the encoder of the active project outputs.



	%encoder_out_file%

	Output file of the video encoder.



	%eval:expression%

	Evaluates a PowerShell expression which may contain macros.



	%filter:name%

	Returns the script code of a filter of the active project that matches the specified name.



	%media_info_audio:property%

	Returns a MediaInfo audio property for the video source file.



	%media_info_video:property%

	Returns a MediaInfo video property for the source file.



	%muxer_ext%

	Output extension of the active muxer.



	%player%

	Path of the media player.



	%plugin_dir%

	AviSynth/VapourSynth plugin auto load directory.



	%pos_frame%

	Current preview position in frames.



	%pos_ms%

	Current preview position in milliseconds.



	%processing%

	Returns ‘True’ if a job is currently processing otherwise ‘False’.



	%programs_dir%

	Programs system directory.



	%script_dir%

	Users PowerShell scripts directory.



	%script_ext%

	File extension of the AviSynth/VapourSynth script so either avs or vpy.



	%script_file%

	Path of the AviSynth/VapourSynth script.



	%sel_end%

	End position of the first selecion in the preview.



	%sel_start%

	Start position of the first selecion in the preview.



	%settings_dir%

	Path of the settings direcory.



	%source_dar%

	Source display aspect ratio.



	%source_dir%

	Directory of the source file.



	%source_dir_name%

	Name of the source file directory.



	%source_dir_parent%

	Parent directory of the source file directory.



	%source_ext%

	File extension of the source file.



	%source_file%

	File path of the source video.



	%source_files%

	Source files in quotes separated by a blank.



	%source_files_comma%

	Source files in quotes separated by comma.



	%source_framerate%

	Frame rate returned by the source filter AviSynth section.



	%source_frames%

	Length in frames of the source video.



	%source_height%

	Image height of the source video.



	%source_name%

	The name of the source file without file extension.



	%source_par_x%

	Source pixel/sample aspect ratio.



	%source_par_y%

	Source pixel/sample aspect ratio.



	%source_seconds%

	Length in seconds of the source video.



	%source_temp_file%

	File located in the temp directory using the same name as the source file.



	%source_video_format%

	Video codec of the source file.



	%source_width%

	Image width of the source video.



	%startup_dir%

	Directory of the application.



	%system_dir%

	System directory.



	%target_dar%

	Target display aspect ratio.



	%target_dir%

	Directory of the target file.



	%target_file%

	File path of the target file.



	%target_framerate%

	Frame rate of the target video.



	%target_frames%

	Length in frames of the target video.



	%target_height%

	Image height of the target video.



	%target_name%

	Name of the target file without file extension.



	%target_par_x%

	Target pixel/sample aspect ratio.



	%target_par_y%

	Target pixel/sample aspect ratio.



	%target_seconds%

	Length in seconds of the target video.



	%target_size%

	Size of the target video in kilo bytes.



	%target_temp_file%

	File located in the temp directory using the same name as the target file.



	%target_width%

	Image width of the target video.



	%temp_dir%

	Directory of the source file or the temp directory if enabled.



	%temp_file%

	File located in the temp directory using the same name as the source file.



	%template_name%

	Name of the template the active project is based on.



	%text_editor%

	Path of the application currently associated with TXT files.



	%version%

	StaxRip version.



	%video_bitrate%

	Video bitrate in Kbps



	%video_encoder%

	Name of the active video encoder.



	%video_encoder_settings%

	Settings of the active video encoder.



	%working_dir%

	Directory of the source file or the temp directory if enabled.












          

      

      

    

  

    
      
          
            
  
Command Line Interface


Note

Switches are processed in the order they appear in the command line.




Examples

StaxRip C:\Movie\project.srip

StaxRip C:\Movie\VTS_01_1.VOB C:\Movie 2\VTS_01_2.VOB

StaxRip -LoadTemplate:DVB C:\Movie\capture.mpg -StartEncoding -Standby

StaxRip -ShowMessageBox:"title ...","text ...",info








Rules

Strings don’t have to be enclosed in quotes unless they contain spaces.




Commands


	
-AddBatchJob:sourcefile

	Adds a batch job.







	sourcefile <string>







	
-AddFilter:active,name,category,script

	Adds a filter at the end of the script.







	active <boolean>



	name <string>



	category <string>



	script <string>







	
-AddJob:showConfirmation,templateName,position

	Adds a job to the job list.







	showConfirmation <boolean>

	Show Confirmation



	templateName <string>

	Template Name: Name of the template to be loaded after the job was added. Empty to load no template.



	position <integer>

	Position to insert new job







	
-AddTags:tags

	Adds tags to the container (works only with mkvmerge).







	tags <string>

	name 1 = value 1; name 2 = value 2; etc.







	
-CheckForUpdate

	Checks if a update is available.






	
-ClearJobs

	Clears the job list.






	
-CopyToClipboard:value

	Copies a string to the clipboard.







	value <string>

	Copies text to the clipboard. May contain macros.







	
-DeleteFiles:dir,filter

	Deletes files in a given directory.







	dir <string>

	Directory: Directory in which to delete files.



	filter <string>

	Example: ‘.txt .log’







	
-DynamicMenuItem:id

	Placeholder for dynamically updated menu items.







	id <dynamicmenuitemid>

	Audio1Profiles, Audio2Profiles, EncoderProfiles, FilterSetupProfiles, MuxerProfiles, RecentProjects, TemplateProjects, HelpApplications, Scripts, AddFilters, InsertFilters, ReplaceFilters, FilterCategory







	
-ExecuteCommandLine:commandLine,waitForExit,showProcessWindow,useShellExecute,workingDirectory

	Executes a command line. If Shell Execute is disabled then macros are passed in as environment variables.







	commandLine <string>

	Command Line: The command line to be executed. Macros are solved.



	waitForExit <boolean>

	Wait For Exit: Halt until the command line returns.



	showProcessWindow <boolean>

	Show Process Window: Redirects the output of console apps to StaxRips process window. Disables Shell Execute.



	useShellExecute <boolean>

	Use Shell Execute: Executes the command line using the shell. Available when the Show Process Window option is disabled.



	workingDirectory <string>

	Working Directory: Working directory the process will use.







	
-ExecutePowerShellScript:code,externalShell

	Executes PowerShell script code.







	code <string>

	Script Code: PowerShell script code to be executed. Macros are expanded.



	externalShell <boolean>

	Use External Shell: Execute in StaxRip to automate StaxRip or use external shell.







	
-ExecuteScriptFile:filepath

	Executes a PowerShell PS1 script file.







	filepath <string>

	File Path: Filepath to a PowerShell PS1 script file. May contain macros.







	
-Exit

	Exits StaxRip






	
-GenerateWikiPages

	Generates various wiki pages.






	
-ImportVideoEncoderCommandLine:commandLine

	Changes video encoder settings.







	commandLine <string>

	Command Line







	
-LoadProfile:videoProfile,audioProfile1,audioProfile2

	Loads a audio or video profile.







	videoProfile <string>

	Video



	audioProfile1 <string>

	Audio 1



	audioProfile2 <string>

	Audio 2







	
-LoadSourceFile:path

	Loads a source file.







	path <string>

	Source File Path







	
-LoadTemplate:name

	Loads a template.







	name <string>







	
-OpenHelpTopic:topic

	Opens a given help topic In the help browser.







	topic <string>

	Help Topic: Name Of the help topic To be opened.







	
-PlaySound:FilePath,Volume

	Plays audio file.







	FilePath <string>

	Filepath to a mp3, wav or wmv sound file.



	Volume <integer>

	Volume (%)







	
-ResetSettings

	Shows a dialog allowing to reset specific settings.






	
-SaveGIF

	Shows a Open File dialog to generate a short GIF.






	
-SaveMKVHDR

	Shows a Open File dialog to add the remaining HDR10 Metadata to a MKV file.






	
-SaveMTN

	Shows a Open File dialog to generate thumbnails using mtn engine






	
-SavePNG

	Shows a open file dialog to create a high quality PNG animation.






	
-SaveProject

	Saves the current project.






	
-SaveProjectAs

	Saves the current project.






	
-SaveProjectAsTemplate

	Saves the current project as template.






	
-SaveProjectPath:path

	Saves the current project at the specified path.







	path <string>

	The path may contain macros.







	
-SetBitrate:bitrate

	Sets the target video bitrate in Kbps.







	bitrate <integer>

	Target Video Bitrate







	
-SetFilter:name,category,script

	Sets a filter replacing a existing filter of same category.







	name <string>



	category <string>



	script <string>







	
-SetHideDialogsOption:hide

	Sets the project option ‘Hide dialogs asking to demux, source filter etc.’







	hide <boolean>







	
-SetPercent:value

	Sets the bitrate according to the compressibility.







	value <integer>

	Percent Value







	
-SetSize:targetSize

	Sets the target file size in MB.







	targetSize <integer>

	Target File Size







	
-SetTargetFile:path

	Sets the file path of the target file.







	path <string>

	Target File Path







	
-SetTargetImageSize:width,height

	Sets the target image size.







	width <integer>



	height <integer>







	
-SetTargetImageSizeByPixel:pixel

	Sets the target image size by pixels (width x height).







	pixel <integer>







	
-ShowAppsDialog

	Dialog to manage external tools.






	
-ShowAudioProfilesDialog:number

	Dialog to manage audio profiles.







	number <integer>

	Track Number (0 or 1)







	
-ShowBatchGenerateThumbnailsDialog

	Shows a dialog to generate thumbnails.






	
-ShowCodePreview

	Dialog to preview script code.






	
-ShowCropDialog

	Shows the crop dialog to crop borders.






	
-ShowDemuxTool

	Allows to use StaxRip’s demuxing GUIs independently.






	
-ShowEncoderProfilesDialog

	Shows a dialog to manage video encoder profiles.






	
-ShowEventCommandsDialog

	Shows the Event Command dialog.






	
-ShowFileBrowserToOpenProject

	Shows a file browser to open a project file.






	
-ShowFilterProfilesDialog

	Dialog to configure filter profiles.






	
-ShowFiltersEditor

	Dialog to edit filters.






	
-ShowFilterSetupProfilesDialog

	Dialog to configure filter setup profiles.






	
-ShowHardcodedSubtitleDialog

	Shows a dialog to add a hardcoded subtitle.






	
-ShowJobsDialog

	Dialog to manage batch jobs.






	
-ShowLogFile

	Shows the log file with the built-in log file viewer.






	
-ShowMacrosDialog

	Dialog that shows available macros.






	
-ShowMainMenuEditor

	Dialog to configure the main menu.






	
-ShowMediaInfo:filepath

	Shows media info on a given file.







	filepath <string>

	May contain macros.







	
-ShowMediaInfoBrowse

	Shows a Open File dialog to show media info.






	
-ShowMediaInfoFolderViewDialog

	Presents MediaInfo of all files in a folder in a grid view.






	
-ShowMessageBox:mainInstruction,content,icon

	Shows a message box.







	mainInstruction <string>

	Main Instruction: Main instruction may contain macros.



	content <string>

	May contain macros.



	icon <msgicon>

	None, Error, Question, Warning, Info







	
-ShowMkvInfo

	Shows a Open File dialog to open a file to be shown by the console tool mkvinfo.






	
-ShowMuxerProfilesDialog

	Dialog to manage Muxer profiles.






	
-ShowOpenSourceBatchFilesDialog

	Dialog to open a file batch source.






	
-ShowOpenSourceBlurayFolderDialog

	Dialog to open a Blu-ray folder source.






	
-ShowOpenSourceDialog

	Dialog to open source files.






	
-ShowOpenSourceMergeFilesDialog

	Dialog to open a merged files source.






	
-ShowOpenSourceSingleFileDialog

	Dialog to open a single file source.






	
-ShowOptionsDialog

	Dialog to configure project options.






	
-ShowPreview

	Dialog to preview or cut the video.






	
-ShowScriptInfo

	Shows script info using various console tools.






	
-ShowSettingsDialog

	Shows the settings dialog.






	
-ShowSizeMenuEditor

	Menu editor for the size menu.






	
-ShowVideoComparison

	Shows a dialog to compare different videos.






	
-Shutdown

	Shut down PC.






	
-Standby

	Standby PC.






	
-StartAutoCrop

	Crops borders automatically.






	
-StartCompCheck

	Starts the compressibility check.






	
-StartEncoding

	Creates a job and runs the job list.






	
-StartJobs

	Runs all active jobs of the job list.






	
-StartSmartCrop

	Crops borders automatically until the proper aspect ratio is found.






	
-StartTool:name

	Starts a tool by name as shown in the app manage dialog.







	name <string>

	Tool Name: Tool name as shown in the app manage dialog.







	
-TestAndDynamicFileCreation

	Development tests and creation of doc files.






	
-WriteLog:header,message

	Writes a log message to the log file.







	header <string>

	Header is optional and may contain macros.



	message <string>

	Message is optional and may contain macros.












          

      

      

    

  

    
      
          
            
  
PowerShell Scripting

StaxRip can be automated via PowerShell scripting.


Script Folder

The Script folder is located at <settings>\Scripts and can be opened from
the main menu under Tools > Scripts > Open Script Folder.

Scripts located in this folder are not loaded automatically but rather can be
invoked from the main menu under Tools > Scripts.




Auto Load Folder

Scripts located under <settings>\Scripts\Auto Load are loaded on startup.

A second startup folder is <startup>\Apps\Scripts, this folder should only
be used by StaxRip maintainers.




Example Scripts

https://github.com/staxrip/staxrip/tree/master/Scripts







          

      

      

    

  

    
      
          
            
  
Frequently Asked Questions


Contents


	Frequently Asked Questions


	How can I encode with a fixed bitrate?


	How can I batch encode with a fixed bitrate?


	Why is encoding with 2 pass using a fixed bitrate not recommended?


	Why don’t settings persist?


	How can I use custom AviSynth and VapourSynth plugins?


	How can I use custom AviSynth scripts?


	Why does AviSynth portable mode require soft links?


	Where can I find the log file?











How can I encode with a fixed bitrate?

In the video encoder config dialog go to the Basic tab and choose a fixed bitrate mode like 2 pass.

At the bottom of the video encoder config dialog there is a drop down menu where a profile can be saved.




How can I batch encode with a fixed bitrate?

StaxRip remembers if the file size or bitrate was edited last so if you edit the bitrate last it will encode using a fixed bitrate.




Why is encoding with 2 pass using a fixed bitrate not recommended?

Sources can vary greatly in complexity depending on the nature of the source, there still might be situations where fixed bitrates are useful.




Why don’t settings persist?

StaxRip loads a default template on startup, templates can be saved with:

Main Menu > File > Save Project As Template

Project options are per Template/Project/Job and settings are global.




How can I use custom AviSynth and VapourSynth plugins?

Custom plugins can either be loaded manually using LoadPlugin():

http://avisynth.nl/index.php/Plugins

Or they can be loaded automatically using the plugin auto load folder.

This folder can be opened in StaxRip with:

Main Menu > Tools > Folders > Plugins

StaxRip is only available for x64 and therefore only x64 plugins can be used.

The AviSynth script can be edited manually using the code editor (Filters > Edit Code) or the filters menu can be configured using the filter profile editor (Filters > Profiles).




How can I use custom AviSynth scripts?

Custom scripts can either be loaded manually using Import():

http://avisynth.nl/index.php/Import

Or they can be loaded automatically using the plugin auto load folder.

This folder can be opened in StaxRip with:

Main Menu > Tools > Folders > Plugins

The AviSynth script can be edited manually using the code editor (Filters > Edit Code) or the filters menu can be configured using the filter profile editor (Filters > Profiles).




Why does AviSynth portable mode require soft links?

StaxRip has portable mode enabled by default because many users have incompatible AviSynth versions installed, portable mode can be disabled in the settings, if AviSynth is installed and portable mode is disabled then soft links are not necessary.

If AviSynth is installed and portable mode should be used instead of the installed version then it can only be achieved with soft links because there is no way to tell a tool from where it should load AviSynth, default DLL loading of the OS applies and that includes the system folder where AviSynth is installed. A tool needs an implementation to use a custom/portable path and right now not all tools have such an implementation.

If AviSynth is not installed then only ffmpeg needs a soft link because ffmpeg blocks default DLL loading of the OS which searches in the PATH environment variable which StaxRip sets in portable mode.




Where can I find the log file?

The StaxRip log file ends with _staxrip.log and can be found in the temp folder, by default the temp folder is located next to the source file.

If a project is re-opened from the Recent menu, then the log file can be opened from the main menu:

File > Recent Projects

Tools > Log File (F7)

The log file history can be found at:

Tools > Folders > Log Files







          

      

      

    

  

    
      
          
            
  
Tools



	Name

	Type

	Filename

	Version

	Modified Date





	AddGrainC

	AviSynth Plugin

	AddGrainC.dll

	1.8.2

	2020-05-20



	AutoAdjust

	AviSynth Plugin

	AutoAdjust.dll

	2.60

	2016-01-05



	Average

	AviSynth Plugin

	Average.dll

	0.94

	2019-01-01



	AviSynthShader DLL

	AviSynth Plugin

	Shader-x64.dll

	1.6.6

	2020-06-17



	AvsResize

	AviSynth Plugin

	avsresize.dll

	r5

	2020-10-30



	AVSTP

	AviSynth Plugin

	avstp.dll

	1.0.3.0

	2019-01-01



	checkmate

	AviSynth Plugin

	checkmate.dll

	0.9

	2013-12-19



	CNR2

	AviSynth Plugin

	CNR2.dll

	2.6.1

	2019-01-01



	D2VSource

	AviSynth Plugin

	D2VSource.dll

	1.2.2

	2021-01-20



	DCTFilter

	AviSynth Plugin

	DCTFilter.dll

	0.5.1

	2020-05-13



	Deblock

	AviSynth Plugin

	Deblock.dll

	2013-12-03

	2019-01-01



	Decomb

	AviSynth Plugin

	Decomb.dll

	5.2.4

	2013-12-01



	DeGrainMedian

	AviSynth Plugin

	DeGrainMedian.dll

	0.8.2

	2019-01-01



	DePan

	AviSynth Plugin

	DePan.dll

	2.7.42

	2020-05-22



	DePanEstimate

	AviSynth Plugin

	DePanEstimate.dll

	2.7.42

	2020-05-22



	DFTTest

	AviSynth Plugin

	dfttest.dll

	1.9.6 Clang

	2020-03-24



	DFTTest Neo

	AviSynth Plugin

	neo-dfttest.dll

	r7

	2020-04-16



	DGDecode

	AviSynth Plugin

	DGDecode.dll

	2.0.0.2

	2021-01-12



	Dither DLL

	AviSynth Plugin

	dither.dll

	1.27.2

	2019-01-01



	DSS2mod

	AviSynth Plugin

	avss.dll

	2014-11-13

	2019-01-01



	EEDI2

	AviSynth Plugin

	EEDI2.dll

	0.9.2.0

	2019-01-01



	EEDI3

	AviSynth Plugin

	EEDI3.dll

	0.9.2.3

	2019-01-01



	f3kdb Neo

	AviSynth Plugin

	neo-f3kdb.dll

	r6

	2020-05-30



	ffms2

	AviSynth Plugin

	ffms2.dll

	87bae19 StvG

	2020-11-23



	FFT3D Neo

	AviSynth Plugin

	neo-fft3d.dll

	r10

	2021-01-02



	FFT3DFilter

	AviSynth Plugin

	fft3dfilter.dll

	2.8

	2020-12-01



	FFT3DGPU

	AviSynth Plugin

	FFT3dGPU.dll

	0.8.6

	2021-01-04



	flash3kyuu_deband

	AviSynth Plugin

	flash3kyuu_deband.dll

	5.0

	2018-05-02



	FluxSmooth

	AviSynth Plugin

	FluxSmooth.dll

	1.4.7

	2019-04-26



	FrameRateConverter DLL

	AviSynth Plugin

	FrameRateConverter-x64.dll

	1.2.1

	2017-09-02



	GradFun2DB

	AviSynth Plugin

	gradfun2db.dll

	2010-03-29

	2019-01-01



	HQDN3D

	AviSynth Plugin

	Hqdn3d.dll

	0.11

	2019-01-01



	JincResize

	AviSynth Plugin

	JincResize.dll

	r44

	2019-01-01



	JPSDR

	AviSynth Plugin

	Plugins_JPSDR.dll

	3.2.4

	2020-11-09



	KNLMeansCL

	AviSynth Plugin

	KNLMeansCL.dll

	1.1.1e

	2020-11-12



	L-SMASH-Works

	AviSynth Plugin

	LSMASHSource.dll

	2020-12-16 StvG

	2020-07-27



	masktools2

	AviSynth Plugin

	masktools2.dll

	2.2.26

	2020-09-04



	MedianBlur2

	AviSynth Plugin

	MedianBlur2.dll

	0.94

	2014-02-10



	MiniDeen

	AviSynth Plugin

	neo-minideen.dll

	r10

	2020-06-20



	MipSmooth

	AviSynth Plugin

	MipSmooth.dll

	1.1.2

	2019-01-01



	modPlus

	AviSynth Plugin

	modPlus.dll

	2017-10-17

	2019-01-01



	MSharpen

	AviSynth Plugin

	msharpen.dll

	0.9

	2013-11-30



	mvtools2

	AviSynth Plugin

	mvtools2.dll

	2.7.44

	2020-12-14



	NicAudio

	AviSynth Plugin

	NicAudio.dll

	1.1

	2019-01-01



	RgTools

	AviSynth Plugin

	RgTools.dll

	1.1

	2021-01-04



	SangNom2

	AviSynth Plugin

	SangNom2.dll

	0.35

	2013-11-30



	SmoothAdjust

	AviSynth Plugin

	SmoothAdjust.dll

	3.20

	2016-01-05



	SmoothD2

	AviSynth Plugin

	SmoothD2.dll

	a2

	2019-01-01



	SVPFlow 1

	AviSynth Plugin

	svpflow1.dll

	4.2.0.133

	2019-01-01



	SVPFlow 2

	AviSynth Plugin

	svpflow2.dll

	4.2.0.142

	2019-01-01



	TDeint

	AviSynth Plugin

	TDeint.dll

	1.8

	2020-12-14



	TEMmod

	AviSynth Plugin

	TEMmod.dll

	0.2.1

	2019-01-01



	TIVTC

	AviSynth Plugin

	TIVTC.dll

	1.0.25

	2020-12-14



	TMM2

	AviSynth Plugin

	TMM2.dll

	0.1.5

	2020-06-30



	TNLMeans

	AviSynth Plugin

	TNLMeans.dll

	1.0.3

	2019-01-01



	UnDot

	AviSynth Plugin

	UnDot.dll

	0.0.1.1

	2006-09-19



	VagueDenoiser

	AviSynth Plugin

	VagueDenoiser.dll

	0.35.1.0

	2019-01-01



	VapourSource

	AviSynth Plugin

	VapourSource_x64.dll

	2018-09-21

	2019-01-01



	vinverse

	AviSynth Plugin

	vinverse.dll

	2013-11-30

	2013-11-30



	vsCube

	AviSynth Plugin

	vscube.dll

	1.0

	2019-01-01



	VSFilterMod

	AviSynth Plugin

	VSFilterMod.dll

	5.2.3

	2020-08-09



	xNLMeans

	AviSynth Plugin

	xNLMeans.dll

	0.03

	2019-01-01



	yadifmod2

	AviSynth Plugin

	yadifmod2.dll

	0.2.2

	2020-05-14



	AnimeIVTC

	AviSynth Script

	AnimeIVTC.avsi

	2.22

	2018-04-17



	AviSynthShader AVSI

	AviSynth Script

	Shader.avsi

	1.6.6

	2018-05-13



	CropResize

	AviSynth Script

	CropResize.avsi

	2019-09-09

	2019-09-10



	DAA3Mod

	AviSynth Script

	daa3mod.avsi

	3.3

	2019-01-01



	Deblock_QED

	AviSynth Script

	Deblock_QED.avsi

	2011-11-29

	2019-01-01



	DehaloAlpha

	AviSynth Script

	Dehalo_alpha.avsi

	MT2

	2019-01-01



	DeNoise Histogram

	AviSynth Script

	DiffCol.avsi

	2018-05-15

	2019-01-01



	DeNoiseMD

	AviSynth Script

	DeNoiseMD.avsi

	2018-05-15

	2019-01-01



	DeNoiseMF

	AviSynth Script

	DeNoiseMF.avsi

	2018-05-15

	2019-01-01



	Dither AVSI

	AviSynth Script

	dither.avsi

	1.27.2

	2019-01-01



	edi_rpow2 AVSI

	AviSynth Script

	edi_rpow2.avsi

	0.9.2.0

	2019-01-01



	eedi3_resize

	AviSynth Script

	eedi3_resize.avsi

	0.11

	2019-01-01



	FineDehalo

	AviSynth Script

	FineDehalo.avsi

	1.1

	2019-01-01



	FineSharp

	AviSynth Script

	FineSharp.avsi

	2012-04-12

	2019-01-01



	FrameRateConverter AVSI

	AviSynth Script

	FrameRateConverter.avsi

	1.2.1

	2019-01-01



	GradFun2DBmod

	AviSynth Script

	GradFun2DBmod.avsi

	1.5

	2019-11-06



	HQDeringmod

	AviSynth Script

	HQDeringmod.avsi

	2018-01-18

	2019-01-01



	InterFrame

	AviSynth Script

	InterFrame.avsi

	2.0

	2019-01-01



	Lazy Utilities

	AviSynth Script

	LUtils.avsi

	0.12

	2019-01-01



	LSFmod

	AviSynth Script

	LSFmod.avsi

	2.187

	2020-05-26



	MAA2Mod

	AviSynth Script

	maa2mod.avsi

	0.431

	2019-01-01



	mClean

	AviSynth Script

	mClean.avsi

	3.2

	2019-01-01



	MCTemporalDenoise

	AviSynth Script

	MCTemporalDenoise.avsi

	1.4.20

	2010-07-02



	MT Expand Multi

	AviSynth Script

	mt_xxpand_multi.avsi

	2018-05-19

	2019-01-01



	MultiSharpen

	AviSynth Script

	MultiSharpen.avsi

	1.0

	2019-01-01



	nnedi3 AVSI

	AviSynth Script

	nnedi3_16.avsi

	3.0

	2019-01-01



	nnedi3x AVSI

	AviSynth Script

	nnedi3x.avsi

	3.0

	2019-01-01



	pSharpen

	AviSynth Script

	pSharpen.avsi

	2016-03-16

	2019-01-01



	QTGMC

	AviSynth Script

	QTGMC.avsi

	3.368s

	2020-08-09



	ResizeX

	AviSynth Script

	ResizeX.avsi

	1.0.1

	2019-01-01



	SMDegrain

	AviSynth Script

	SMDegrain.avsi

	3.12.108s

	2020-05-31



	SmoothD2c

	AviSynth Script

	SmoothD2c.avs

	a2

	2019-01-01



	TemporalDegrain2

	AviSynth Script

	TemporalDegrain2.avsi

	2.2.1

	2019-02-24



	YFRC

	AviSynth Script

	YFRC.avsi

	2015-10-01

	2019-01-01



	Zs_RF_Shared

	AviSynth Script

	Zs_RF_Shared.avsi

	1.127

	2020-05-31



	7zip

	Console App

	7za.exe

	19.0

	2019-02-21



	aomenc

	Console App

	aomenc.exe

	2.0.1-1118 msvc1929 Patman

	2020-12-23



	AutoCrop

	Console App

	AutoCrop.exe

	2.1.0.0

	2020-12-30



	avs2pipemod

	Console App

	avs2pipemod64.exe

	1.1.1 UTF8 + long path Mod

	2021-02-04



	AVSMeter

	Console App

	AVSMeter64.exe

	3.0.7.0

	2020-11-16



	eac3to

	Console App

	eac3to.exe

	3.34

	2017-11-19



	fdkaac

	Console App

	fdkaac.exe

	1.0.0

	2019-02-13



	ffmpeg

	Console App

	ffmpeg.exe

	N-101189 gcc10.2.0 Patman

	2021-02-20



	ffmpeg non-free

	Console App

	ffmpeg.exe

	
	2020-08-30



	mkvextract

	Console App

	mkvextract.exe

	53

	2021-01-30



	mkvinfo

	Console App

	mkvinfo.exe

	53

	2021-01-30



	mkvmerge

	Console App

	mkvmerge.exe

	53

	2021-01-30



	MP4Box

	Console App

	MP4Box.exe

	1.1.0 rev506 gcc10.2 Patman

	2021-02-11



	mtn

	Console App

	mtn.exe

	2.0.1

	2019-06-27



	NeroAAC

	Console App

	neroAacEnc.exe

	
	2010-02-18



	NVEnc

	Console App

	NVEncC64.exe

	5.29

	2021-02-14



	PNGopt

	Console App

	apngopt.exe

	1.4

	2019-01-01



	Python

	Console App

	python.exe

	3.8.5150

	2020-07-20



	qaac

	Console App

	qaac64.exe

	2.71

	2020-10-02



	QSVEnc

	Console App

	QSVEncC64.exe

	4.13

	2021-02-17



	rav1e

	Console App

	rav1e.exe

	0.4.0

	2021-01-15



	SVT-AV1

	Console App

	SvtAv1EncApp.exe

	0.8.6

	2020-11-29



	VCEEnc

	Console App

	VCEEncC64.exe

	6.09

	2021-02-18



	vspipe

	Console App

	vspipe.exe

	r52

	2021-02-20



	x264

	Console App

	x264.exe

	0.161.3048+17 gcc10.2.0 Patman Mod

	2021-02-20



	x265

	Console App

	x265.exe

	3.4+70-aMod-gcc10.2.1 DJATOM Mod

	2021-02-02



	xvid_encraw

	Console App

	xvid_encraw.exe

	1.3.7

	


	BDSup2Sub++

	GUI App

	bdsup2sub++.exe

	1.0.3

	2018-05-09



	chapterEditor

	GUI App

	chapterEditor.exe

	1.25

	2020-10-04



	D2V Witch

	GUI App

	d2vwitch.exe

	v5

	


	DGIndex

	GUI App

	DGIndex.exe

	2.0.0.2

	2021-01-12



	MediaInfo.NET

	GUI App

	MediaInfoNET.exe

	6.8.0.0

	2020-12-13



	MKVToolnix GUI

	GUI App

	mkvtoolnix-gui.exe

	53

	2021-01-30



	MPC

	GUI App

	mpc-be64.exe

	
	2020-12-09



	mpv.net

	GUI App

	mpvnet.exe

	5.4.8.6

	2020-12-30



	Subtitle Edit

	GUI App

	SubtitleEdit.exe

	3.6.0

	2021-02-18



	VSRip

	GUI App

	VSRip.exe

	1.0.0.7

	2011-07-14



	Apple Application Support

	Library

	CoreAudioToolbox.dll

	
	2020-10-16



	AviSynth

	Library

	AviSynth.dll

	3.7

	2021-01-11



	DirectX 9

	Library

	d3d9.dll

	
	2020-12-09



	FFTW

	Library

	libfftw3-3.dll

	3.3.8

	2018-12-20



	MediaInfo

	Library

	MediaInfo.dll

	20.09

	2020-10-09



	VapourSynth

	Library

	vapoursynth.dll

	r52

	2020-08-20



	Visual C++ 2010

	Library

	msvcp100.dll

	
	2011-06-11



	Visual C++ 2012

	Library

	msvcp110.dll

	
	2012-11-05



	Visual C++ 2013

	Library

	msvcp120.dll

	
	2016-02-10



	Visual C++ 2015-2019

	Library

	msvcp140.dll

	14.28.29334

	2020-11-11



	Get-MediaInfo

	Misc

	Get-MediaInfo.ps1

	3.5

	2021-01-10



	Haali Splitter

	Misc

	splitter.ax

	
	


	AWarpSharp2

	VapourSynth Plugin

	libawarpsharp2.dll

	2018-06-18

	2019-01-01



	BM3D

	VapourSynth Plugin

	BM3D.dll

	r8

	2019-01-03



	Bwdif

	VapourSynth Plugin

	Bwdif.dll

	r2

	2020-06-19



	CAS

	VapourSynth Plugin

	CAS.dll

	r2

	2020-07-05



	CNR2

	VapourSynth Plugin

	libcnr2.dll

	2016-07-02

	2019-01-01



	CTMF

	VapourSynth Plugin

	CTMF.dll

	2017-06-02

	2019-01-01



	d2vsource

	VapourSynth Plugin

	d2vsource.dll

	1.2

	2019-08-06



	DCTFilter

	VapourSynth Plugin

	DCTFilter.dll

	r2

	2017-12-23



	DCTFilter-f

	VapourSynth Plugin

	DCTFilter.dll

	r2

	2019-01-01



	Deblock

	VapourSynth Plugin

	Deblock.dll

	6

	2017-06-13



	DeblockPP7

	VapourSynth Plugin

	DeblockPP7.dll

	2018-04-28

	2019-01-01



	DegrainMedian

	VapourSynth Plugin

	libdegrainmedian.dll

	2016-08-07

	2019-01-01



	DFTTest

	VapourSynth Plugin

	DFTTest.dll

	r7

	2020-07-04



	EEDI2

	VapourSynth Plugin

	EEDI2.dll

	2017-03-04

	2019-01-01



	EEDI3m

	VapourSynth Plugin

	EEDI3m.dll

	2017-12-23

	2019-01-01



	FFT3DFilter

	VapourSynth Plugin

	fft3dfilter.dll

	2018-07-11

	2019-01-01



	FixTelecinedFades

	VapourSynth Plugin

	libftf_em64t_avx_fma.dll

	5.0

	2017-01-28



	FluxSmooth

	VapourSynth Plugin

	libfluxsmooth.dll

	2.0

	2019-01-01



	fmtconv

	VapourSynth Plugin

	fmtconv.dll

	20

	2016-03-25



	HQDN3D

	VapourSynth Plugin

	libhqdn3d.dll

	2018-07-01

	2019-01-01



	IT

	VapourSynth Plugin

	vs_it.dll

	1.2

	2019-01-01



	msmoosh

	VapourSynth Plugin

	libmsmoosh.dll

	1.1

	2014-09-26



	mvtools

	VapourSynth Plugin

	libmvtools.dll

	r20

	2019-03-13



	mvtools-sf

	VapourSynth Plugin

	libmvtools_sf_em64t.dll

	r1

	2017-06-20



	nnedi3

	VapourSynth Plugin

	libnnedi3.dll

	v12

	2019-01-01



	nnedi3cl

	VapourSynth Plugin

	NNEDI3CL.dll

	7.2

	2019-01-01



	Sangnom

	VapourSynth Plugin

	libsangnom.dll

	2016-08-31

	2019-01-01



	scenechange

	VapourSynth Plugin

	scenechange.dll

	2014-09-25

	2014-09-25



	SVPFlow 1

	VapourSynth Plugin

	svpflow1_vs64.dll

	4.2.0.133

	2019-01-01



	SVPFlow 2

	VapourSynth Plugin

	svpflow2_vs64.dll

	4.2.0.142

	2019-01-01



	TCanny

	VapourSynth Plugin

	TCanny.dll

	r12

	2019-02-05



	TDeintMod

	VapourSynth Plugin

	TDeintMod.dll

	r10

	2019-01-01



	TemporalMedian

	VapourSynth Plugin

	libtemporalmedian.dll

	v1

	2019-01-01



	temporalsoften

	VapourSynth Plugin

	temporalsoften.dll

	2014-09-25

	2014-09-25



	TimeCube

	VapourSynth Plugin

	vscube.dll

	2.0

	2019-01-01



	TTempSmooth

	VapourSynth Plugin

	TTempSmooth.dll

	2018-05-08

	2019-01-01



	VagueDenoiser

	VapourSynth Plugin

	VagueDenoiser.dll

	2015-06-08

	2019-01-01



	vcfreq

	VapourSynth Plugin

	vcfreq.dll

	2016-05-12

	2019-01-01



	vcmod

	VapourSynth Plugin

	vcmod.dll

	2017-10-17

	2019-01-01



	vcmove

	VapourSynth Plugin

	vcmove.dll

	2016-04-10

	2019-01-01



	W3FDIF

	VapourSynth Plugin

	W3FDIF.dll

	r1

	2019-01-01



	Yadifmod

	VapourSynth Plugin

	Yadifmod.dll

	r10

	2017-02-07



	znedi3

	VapourSynth Plugin

	vsznedi3.dll

	2018-01-11

	2019-01-01



	adjust

	VapourSynth Script

	adjust.py

	2015-03-22

	2019-01-01



	Dither

	VapourSynth Script

	Dither.py

	2018-02-23

	2019-01-01



	finesharp

	VapourSynth Script

	finesharp.py

	2018-06-30

	2019-01-01



	fvsfunc

	VapourSynth Script

	fvsfunc.py

	2018-10-28

	2019-01-01



	G41Fun

	VapourSynth Script

	G41Fun.py

	1.0

	2019-01-01



	havsfunc

	VapourSynth Script

	havsfunc.py

	33

	2020-07-06



	mcdegrainsharp

	VapourSynth Script

	mcdegrainsharp.py

	2016-10-20

	2019-01-01



	muvsfunc

	VapourSynth Script

	muvsfunc.py

	0.2.0

	2019-02-18



	mvmulti

	VapourSynth Script

	mvmulti.py

	20

	2019-01-01



	mvsfunc

	VapourSynth Script

	mvsfunc.py

	2016-10-03

	2016-07-24



	nnedi3_rpow2

	VapourSynth Script

	nnedi3_rpow2.py

	1.0

	2017-09-14



	Oyster

	VapourSynth Script

	Oyster.py

	2017-02-10

	2019-01-01



	Plum

	VapourSynth Script

	Plum.py

	2017-06-24

	2019-01-01



	psharpen

	VapourSynth Script

	psharpen.py

	1.0

	2019-01-01



	resamplehq

	VapourSynth Script

	resamplehq.py

	1.0

	2019-01-01



	taa

	VapourSynth Script

	vsTAAmbk.py

	0.8.0

	2019-01-01



	Vine

	VapourSynth Script

	Vine.py

	2017-03-16

	2019-01-01







Console App


7zip

Packing console app.

https://www.7-zip.org




aomenc

AV1 video encoder console app.

https://aomedia.org




AutoCrop

AutoCrop console app.




avs2pipemod

Console app given an AviSynth script as input, avs2pipemod can send video, audio, or information of various types to stdout for consumption by command line encoders or other tools.

http://github.com/chikuzen/avs2pipemod




AVSMeter

Console app that displays AviSynth script clip info.

http://forum.doom9.org/showthread.php?t=174797




eac3to

Audio convertor console app.

http://forum.doom9.org/showthread.php?t=125966




fdkaac

Non-free AAC console encoder using libfdk-aac.

http://github.com/nu774/fdkaac




ffmpeg

Versatile and free audio video convertor console app.

http://ffmpeg.org




ffmpeg non-free

Versatile audio video convertor console app. Custom build with non-free libraries like fdk-aac.

http://ffmpeg.org




mkvextract

MKV demuxing tool.

https://mkvtoolnix.download




mkvinfo

MKV info tool.

https://mkvtoolnix.download




mkvmerge

MKV muxing tool.

https://mkvtoolnix.download




MP4Box

MP4Box is a MP4 muxing and demuxing console app.

http://gpac.wp.mines-telecom.fr




mtn

Movie thumbnailer saves thumbnails (screenshots) of movie or video files to jpeg files. StaxRip uses a custom built version with HEVC support added in and also includes the latest FFMPEG.

https://github.com/Revan654/Movie-Thumbnailer-mtn




NeroAAC

Non-free AAC audio convertor console app.




NVEnc

NVIDIA hardware video encoder.

http://github.com/rigaya/NVEnc




PNGopt

Opt Tools For Creating PNG

https://sourceforge.net/projects/apng/files




Python

Scripting language used by VapourSynth.

http://www.python.org




qaac

Console AAC encoder using the non-free Apple AAC encoder.

http://github.com/nu774/qaac




QSVEnc

Intel hardware video encoder.

http://github.com/rigaya/QSVEnc




rav1e

AV1 Video Encoder.

https://github.com/xiph/rav1e




SVT-AV1

Intel AV1 encoder.

https://github.com/OpenVisualCloud/SVT-AV1




VCEEnc

AMD hardware video encoder.

http://github.com/rigaya/VCEEnc




vspipe

Console app that pipes VapourSynth scripts to video encoding console apps.

http://www.vapoursynth.com




x264

H.264 video encoding console app.

https://github.com/staxrip/staxrip/wiki/x264




x265

H.265 video encoding console app.

https://x265.com




xvid_encraw

MPEG-4 video encoder console app.

https://www.xvid.com






GUI App


BDSup2Sub++

GUI app that converts Blu-ray subtitles to other formats like VobSub.

https://github.com/amichaeltm/BDSup2SubPlusPlus




chapterEditor

GUI app to edit chapters and menus for OGG, XML, TTXT, m.AVCHD, m.editions-mkv, Matroska Menu.

https://forum.doom9.org/showthread.php?t=169984




D2V Witch

Portable MPEG-2 demuxing and d2v indexing GUI app.

https://github.com/dubhater/D2VWitch




DGIndex

MPEG-2 demuxing and d2v indexing GUI app.

http://rationalqm.us/dgmpgdec/dgmpgdec.html




MediaInfo.NET

GUI app originally built for StaxRip to show info about media files.

https://github.com/stax76/MediaInfo.NET




MKVToolnix GUI

MKV muxing/demuxing GUI app.

https://mkvtoolnix.download




MPC

DirectShow based media player (GUI app).

https://sourceforge.net/projects/mpcbe




mpv.net

The worlds best media player (GUI app).

https://github.com/stax76/mpv.net




Subtitle Edit

Subtitle editor GUI app.

http://www.nikse.dk/SubtitleEdit




VSRip

GUI app that rips VobSub subtitles.

http://sourceforge.net/projects/guliverkli






AviSynth Plugin


AddGrainC

Generate film-like grain or other effects (like rain) by adding random noise to a video clip.

Filters: AddGrainC, AddGrain

https://github.com/pinterf/AddGrainC




AutoAdjust

Automatic adjustement video filter plugin that calculates statistics of clip, stabilizes them temporally and uses them to adjust luminance gain & color balance.

Filters: AutoAdjust

http://forum.doom9.org/showthread.php?t=167573




Average

A simple video filter plugin that calculates a weighted frame-by-frame average from multiple clips.

Filters: Average

http://avisynth.nl/index.php/Average




AviSynthShader DLL

Filters: SuperRes, SuperResXBR, SuperXBR, ResizeShader, SuperResPass, SuperXbrMulti, ResizeShader

https://github.com/mysteryx93/AviSynthShader




AvsResize

Filters: z_ConvertFormat, z_PointResize, z_BilinearResize, z_BicubicResize, z_LanczosResize, z_Lanczos4Resize, z_Spline16Resize, z_Spline36Resize, z_Spline64Resize

http://avisynth.nl/index.php/Avsresize




AVSTP

AVSTP is a programming library for Avisynth plug-in developers. It helps supporting native multi-threading in plug-ins. It works by sharing a thread pool between multiple plug-ins, so the number of threads stays low whatever the number of instantiated plug-ins. This helps saving resources, especially when working in an Avisynth MT environment. This documentation is mostly targeted to plug-ins developpers, but contains installation instructions for Avisynth users too.

Filters: avstp_set_threads

http://avisynth.nl/index.php/AVSTP




checkmate

Spatial and temporal dot crawl reducer. Checkmate is most effective in static or low motion scenes.

Filters: checkmate

http://github.com/tp7/checkmate




CNR2

A fast chroma denoiser. Very effective against stationary rainbows and huge analogic chroma activity. Useful to filter VHS/TV caps.

Filters: cnr2

http://avisynth.nl/index.php/Cnr2




D2VSource

Source filter to open D2V index files created with DGIndex or D2V Witch.

Filters: D2VSource

https://github.com/Asd-g/MPEG2DecPlus




DCTFilter

A rewrite of DctFilter for Avisynth+.

Filters: DCTFilter, DCTFilterD, DCTFilter4, DCTFilter4D, DCTFilter8, DCTFilter8D

https://github.com/Asd-g/DCTFilter




Deblock

Deblocking plugin using the deblocking filter of h264.

Filters: Deblock

http://avisynth.nl/index.php/DeBlock




Decomb

Video filter plugin that provides the means for removing combing artifacts from telecined progressive streams, interlaced streams, and mixtures thereof.

Filters: Telecide, FieldDeinterlace, Decimate, IsCombed

http://rationalqm.us/decomb/decombnew.html




DeGrainMedian

DeGrainMedian is a spatio-temporal limited median filter mainly for film grain removal, but may be used for general denoising.

Filters: DeGrainMedian

http://avisynth.nl/index.php/DeGrainMedian




DePan

Filters: DePan, DePanInterleave, DePanStabilize, DePanScenes

https://github.com/pinterf/mvtools




DePanEstimate

Filters: DePanEstimate

https://github.com/pinterf/mvtools




DFTTest

2D/3D frequency domain denoiser using Discrete Fourier transform.

Filters: dfttest

https://github.com/pinterf/dfttest




DFTTest Neo

2D/3D frequency domain denoiser using Discrete Fourier transform.

Filters: neo_dfttest

https://github.com/HomeOfAviSynthPlusEvolution/neo_DFTTest




DGDecode

Source filter to open D2V index files created with DGIndex or D2V Witch.

Filters: MPEG2Source

http://rationalqm.us/dgmpgdec/dgmpgdec.html




Dither DLL

This package offers a set of tools to manipulate high-bitdepth (16 bits per plane) video clips. The most proeminent features are color banding artifact removal, dithering to 8 bits, colorspace conversions and resizing.

Filters: Dither_y_gamma_to_linear, Dither_y_linear_to_gamma, Dither_convert_8_to_16, Dither1Pre, Dither1Pre, Dither_repair16, Dither_convert_yuv_to_rgb, Dither_convert_rgb_to_yuv, Dither_resize16, DitherPost, Dither_crop16, DitherBuildMask, SmoothGrad, GradFun3, Dither_box_filter16, Dither_bilateral16, Dither_limit_dif16, Dither_resize16nr, Dither_srgb_display, Dither_convey_yuv4xxp16_on_yvxx, Dither_convey_rgb48_on_yv12, Dither_removegrain16, Dither_median16, Dither_get_msb, Dither_get_lsb, Dither_addborders16, Dither_lut8, Dither_lutxy8, Dither_lutxyz8, Dither_lut16, Dither_add16, Dither_sub16, Dither_max_dif16, Dither_min_dif16, Dither_merge16, Dither_merge16_8, Dither_sigmoid_direct, Dither_sigmoid_inverse, Dither_add_grain16, Dither_Luma_Rebuild

http://avisynth.nl/index.php/Dither




DSS2mod

Direct Show source filter

Filters: DSS2

http://code.google.com/p/xvid4psp/downloads/detail?name=DSS2%20mod%20%2B%20LAVFilters.7z&can=2&q=




EEDI2

EEDI2 (Enhanced Edge Directed Interpolation) resizes an image by 2x in the vertical direction by copying the existing image to 2*y(n) and interpolating the missing field.

Filters: EEDI2

http://avisynth.nl/index.php/EEDI2




EEDI3

EEDI3 (Enhanced Edge Directed Interpolation) resizes an image by 2x in the vertical direction by copying the existing image to 2*y(n) and interpolating the missing field.

Filters: EEDI3

http://avisynth.nl/index.php/EEDI3




f3kdb Neo

Debanding filter forked from flash3kyuu_deband.

Filters: neo_f3kdb

https://github.com/HomeOfAviSynthPlusEvolution/neo_f3kdb




ffms2

AviSynth+ and VapourSynth source filter supporting various input formats.

Filters: FFVideoSource, FFAudioSource, FFMS2

http://github.com/FFMS/ffms2




FFT3D Neo

Neo FFT3D is a 3D Frequency Domain filter - strong denoiser and moderate sharpener.

Filters: neo_fft3d

https://github.com/HomeOfAviSynthPlusEvolution/neo_FFT3D




FFT3DFilter

FFT3DFilter uses Fast Fourier Transform method for image processing in frequency domain.

Filters: FFT3DFilter

http://github.com/pinterf/fft3dfilter




FFT3DGPU

Similar algorithm to FFT3DFilter, but uses graphics hardware for increased speed.

Filters: FFT3DGPU

https://github.com/pinterf/FFT3dGPU




flash3kyuu_deband

Simple debanding filter that can be quite effective for some anime sources.

Filters: f3kdb

http://forum.doom9.org/showthread.php?t=161411




FluxSmooth

One of the fundamental properties of noise is that it’s random. One of the fundamental properties of motion is that it’s not. This is the premise behind FluxSmooth, which examines each pixel and compares it to the corresponding pixel in the previous and last frame. Smoothing occurs if both the previous frame’s value and the next frame’s value are greater, or if both are less, than the value in the current frame.

Filters: FluxSmoothT, FluxSmoothST

http://avisynth.nl/index.php/FluxSmooth




FrameRateConverter DLL

Increases the frame rate with interpolation and fine artifact removal

Filters: FrameRateConverter

https://github.com/mysteryx93/FrameRateConverter




GradFun2DB

A simple and fast debanding filter.

Filters: gradfun2db

http://avisynth.nl/index.php/GradFun2db




HQDN3D

Filters: HQDN3D

http://avisynth.nl/index.php/Hqdn3d




JincResize

Jinc (EWA Lanczos) resampling plugin for AviSynth 2.6/AviSynth+.

Filters: Jinc36Resize, Jinc64Resize, Jinc144Resize, Jinc256Resize

http://avisynth.nl/index.php/JincResize




JPSDR

Merge of AutoYUY2, NNEDI3, HDRTools, aWarpSharpMT and ResampleMT. Included is the W7 AVX variant.

Filters: aBlur, aSobel, AutoYUY2, aWarp, aWarp4, aWarpSharp2, BicubicResizeMT, BilinearResizeMT, BlackmanResizeMT, ConvertLinearRGBtoYUV, ConvertRGB_Hable_HDRtoSDR, ConvertRGB_Mobius_HDRtoSDR, ConvertRGB_Reinhard_HDRtoSDR, ConvertRGBtoXYZ, ConvertXYZ_Hable_HDRtoSDR, ConvertXYZ_Mobius_HDRtoSDR, ConvertXYZ_Reinhard_HDRtoSDR, ConvertXYZ_Scale_HDRtoSDR, ConvertXYZ_Scale_SDRtoHDR, ConvertXYZtoRGB, ConvertXYZtoYUV, ConvertYUVtoLinearRGB, ConvertYUVtoXYZ, DeBicubicResizeMT, DeBilinearResizeMT, DeBlackmanResizeMT, DeGaussResizeMT, DeLanczos4ResizeMT, DeLanczosResizeMT, DeSincResizeMT, DeSpline16ResizeMT, DeSpline36ResizeMT, DeSpline64ResizeMT, GaussResizeMT, Lanczos4ResizeMT, LanczosResizeMT, nnedi3, PointResizeMT, SincResizeMT, Spline16ResizeMT, Spline36ResizeMT, Spline64ResizeMT

https://github.com/jpsdr/plugins_JPSDR




KNLMeansCL

KNLMeansCL is an optimized pixelwise OpenCL implementation of the Non-local means denoising algorithm. Every pixel is restored by the weighted average of all pixels in its search window. The level of averaging is determined by the filtering parameter h.

Filters: KNLMeansCL

https://github.com/pinterf/KNLMeansCL




L-SMASH-Works

AviSynth and VapourSynth source filter based on Libav supporting a wide range of input formats.

Filters: LSMASHVideoSource, LSMASHAudioSource, LWLibavVideoSource, LWLibavAudioSource

https://github.com/HolyWu/L-SMASH-Works




masktools2

MaskTools2 contain a set of filters designed to create, manipulate and use masks. Masks, in video processing, are a way to give a relative importance to each pixel. You can, for example, create a mask that selects only the green parts of the video, and then replace those parts with another video.

Filters: mt_adddiff, mt_average, mt_binarize, mt_circle, mt_clamp, mt_convolution, mt_diamond, mt_edge, mt_ellipse, mt_expand, mt_hysteresis, mt_inflate, mt_inpand, mt_invert, mt_logic, mt_losange, mt_lut, mt_lutf, mt_luts, mt_lutxy, mt_makediff, mt_mappedblur, mt_merge, mt_motion, mt_polish, mt_rectangle, mt_square

http://github.com/pinterf/masktools




MedianBlur2

Constant time median video filter plugin.

Filters: MedianBlur, MedianBlurTemporal

http://avisynth.nl/index.php/MedianBlur2




MiniDeen

MiniDeen is a spatial denoising filter which replaces every pixel with the average of its neighbourhood.

Filters: MiniDeen

https://github.com/HomeOfAviSynthPlusEvolution/MiniDeen




MipSmooth

a reinvention of SmoothHiQ and Convolution3D. MipSmooth was made to enable smoothing of larger pixel areas than 3x3(x3), to remove blocks and smoothing out low-frequency noise.

Filters: MipSmooth

http://avisynth.org.ru/docs/english/externalfilters/mipsmooth.htm




modPlus

Video filter plugin which modify values of color components to attenuate noise, blur or equalize input.

Filters: GBlur, MBlur, Median, minvar, Morph, SaltPepper, SegAmp, TweakHist, Veed

http://www.avisynth.nl/users/vcmohan/modPlus/modPlus.html




MSharpen

Filters: MSharpen

http://avisynth.nl/index.php/MSharpen




mvtools2

MVTools is collection of functions for estimation and compensation of objects motion in video clips. Motion compensation may be used for strong temporal denoising, advanced framerate conversions, image restoration and other tasks.

Filters: MSuper, MAnalyse, MCompensate, MMask, MDeGrain1, MDeGrain2, MDegrain3

http://github.com/pinterf/mvtools




NicAudio

AviSynth audio source filter plugin.

Filters: NicAC3Source, NicDTSSource, NicMPASource, RaWavSource

http://avisynth.org.ru/docs/english/externalfilters/nicaudio.htm




RgTools

RgTools is a modern rewrite of RemoveGrain, Repair, BackwardClense, Clense, ForwardClense and VerticalCleaner all in a single plugin.

Filters: RemoveGrain, Clense, ForwardClense, BackwardClense, Repair, VerticalCleaner

http://github.com/pinterf/RgTools




SangNom2

SangNom2 is a reimplementation of MarcFD’s old SangNom filter. Originally it’s a single field deinterlacer using edge-directed interpolation but nowadays it’s mainly used in anti-aliasing scripts. The output is not completely but mostly identical to the original SangNom.

Filters: SangNom2

http://avisynth.nl/index.php/SangNom2




SmoothAdjust

SmoothAdjust is a video filter plugin to make YUV adjustements.

Filters: SmoothTweak, SmoothCurve, SmoothCustom, SmoothTools

http://forum.doom9.org/showthread.php?t=154971




SmoothD2

Deblocking filter. Rewrite of SmoothD. Faster, better detail preservation, optional chroma deblocking.

Filters: SmoothD2

http://avisynth.nl/index.php/SmoothD2




SVPFlow 1

Motion vectors search plugin  is a deeply refactored and modified version of MVTools2 Avisynth plugin

Filters: analyse_params, super_params, SVSuper, SVAnalyse

http://avisynth.nl/index.php/SVPFlow




SVPFlow 2

Motion vectors search plugin is a deeply refactored and modified version of MVTools2 Avisynth plugin

Filters: smoothfps_params, SVConvert, SVSmoothFps

http://avisynth.nl/index.php/SVPFlow




TDeint

TDeint is a bi-directionally, motion adaptive, sharp deinterlacer.

Filters: TDeint

https://github.com/pinterf/TIVTC




TEMmod

TEMmod creates an edge mask using gradient vector magnitude.

Filters: TEMmod

http://avisynth.nl/index.php/TEMmod




TIVTC

TIVTC is a plugin package containing 7 different filters and 3 conditional functions.

Filters: TFM, TDecimate, MergeHints, FrameDiff, FieldDiff, ShowCombedTIVTC, RequestLinear

http://github.com/pinterf/TIVTC




TMM2

TMM builds a motion-mask for TDeint, which TDeint uses via its ‘emask’ parameter.

Filters: TMM2

https://github.com/Asd-g/TMM2




TNLMeans

TNLMeans is an implementation of the NL-means denoising algorithm. Aside from the original method, TNLMeans also supports extension into 3D, a faster, block based approach, and a multiscale version.

Filters: TNLMeans

http://avisynth.nl/index.php/TNLMeans




UnDot

UnDot is a simple median filter plugin for removing dots, that is stray orphan pixels and mosquito noise.

Filters: UnDot

http://avisynth.nl/index.php/UnDot




VagueDenoiser

This is a Wavelet based Denoiser. Basically, it transforms each frame from the video input into the wavelet domain, using various wavelet filters. Then it applies some filtering to the obtained coefficients.

Filters: VagueDenoiser

http://avisynth.nl/index.php/VagueDenoiser




VapourSource

VapourSource is a VapourSynth script reader for AviSynth 2.6.

Filters: VSImport, VSEval

http://avisynth.nl/index.php/VapourSource




vinverse

Simple but effective plugin to remove residual combing.

Filters: vinverse, vinverse2

http://avisynth.nl/index.php/Vinverse




vsCube

Deblocking plugin using the deblocking filter of h264.

Filters: Cube

http://rationalqm.us/mine.html




VSFilterMod

AviSynth and VapourSynth subtitle plugin with support for vobsub srt and ass.

Filters: VobSub, TextSubMod

https://github.com/sorayuki/VSFilterMod




xNLMeans

XNLMeans is an AviSynth plugin implementation of the Non Local Means denoising algorithm

Filters: xNLMeans

http://avisynth.nl/index.php/xNLMeans




yadifmod2

Yet Another Deinterlacing Filter mod

Filters: yadifmod2

https://github.com/Asd-g/yadifmod2






AviSynth Script


AnimeIVTC

Filters: AnimeIVTC

http://avisynth.nl/index.php/AnimeIVTC




AviSynthShader AVSI

Filters: SuperRes, SuperResXBR, SuperXBR, ResizeShader, SuperResPass, SuperXbrMulti, ResizeShader

https://github.com/mysteryx93/AviSynthShader




CropResize

Advanced crop and resize AviSynth script.

Filters: CropResize

https://forum.videohelp.com/threads/393752-CropResize-Cropping-resizing-script




DAA3Mod

Motion-Compensated Anti-aliasing with contra-sharpening, can deal with ifade too, created because when applied daa3 to fixed scenes, it could damage some details and other issues.

Filters: daa3mod, mcdaa3

http://avisynth.nl/index.php/daa3




Deblock_QED

Designed to provide 8x8 deblocking sensitive to the amount of blocking in the source, compared to other deblockers which apply a uniform deblocking across every frame.

Filters: Deblock_QED

http://avisynth.nl/index.php/Deblock_QED




DehaloAlpha

Reduce halo artifacts that can occur when sharpening.

Filters: DeHalo_alpha_mt, DeHalo_alpha_2BD




DeNoise Histogram

Histogram for both DenoiseMD and DenoiseMF

Filters: DiffCol

http://avisynth.nl




DeNoiseMD

A fast and accurate denoiser for a Full HD video from a H.264 camera.

Filters: DeNoiseMD1, DenoiseMD2

http://avisynth.nl




DeNoiseMF

A fast and accurate denoiser for a Full HD video from a H.264 camera.

Filters: DeNoiseMF1, DenoiseMF2

http://avisynth.nl




Dither AVSI

This package offers a set of tools to manipulate high-bitdepth (16 bits per plane) video clips. The most proeminent features are color banding artifact removal, dithering to 8 bits, colorspace conversions and resizing.

Filters: Dither_y_gamma_to_linear, Dither_y_linear_to_gamma, Dither_convert_8_to_16, Dither1Pre, Dither1Pre, Dither_repair16, Dither_convert_yuv_to_rgb, Dither_convert_rgb_to_yuv, Dither_resize16, DitherPost, Dither_crop16, DitherBuildMask, SmoothGrad, GradFun3, Dither_box_filter16, Dither_bilateral16, Dither_limit_dif16, Dither_resize16nr, Dither_srgb_display, Dither_convey_yuv4xxp16_on_yvxx, Dither_convey_rgb48_on_yv12, Dither_removegrain16, Dither_median16, Dither_get_msb, Dither_get_lsb, Dither_addborders16, Dither_lut8, Dither_lutxy8, Dither_lutxyz8, Dither_lut16, Dither_add16, Dither_sub16, Dither_max_dif16, Dither_min_dif16, Dither_merge16, Dither_merge16_8, Dither_sigmoid_direct, Dither_sigmoid_inverse, Dither_add_grain16, Dither_Luma_Rebuild

http://avisynth.nl/index.php/Dither




edi_rpow2 AVSI

An improved rpow2 function for nnedi3, nnedi3ocl, eedi3, and eedi2.

Filters: nnedi3_rpow2

http://avisynth.nl/index.php/nnedi3




eedi3_resize

eedi3 based resizing script that allows to resize to arbitrary resolutions while maintaining the correct image center and chroma location.

Filters: eedi3_resize

http://avisynth.nl/index.php/eedi3




FineDehalo

Halo removal script that uses DeHalo_alpha with a few masks and optional contra-sharpening to try remove halos without removing important details (like line edges). It also includes FineDehalo2, this function tries to remove 2nd order halos. See script for extensive information.

Filters: FineDehalo

http://avisynth.nl/index.php/FineDehalo




FineSharp

Small and fast realtime-sharpening function for 1080p, or after scaling 720p -> 1080p. It’s a generic sharpener only for good quality sources!

Filters: FineSharp

http://avisynth.nl/index.php/FineSharp




FrameRateConverter AVSI

Increases the frame rate with interpolation and fine artifact removal

Filters: FrameRateConverter

https://github.com/mysteryx93/FrameRateConverter




GradFun2DBmod

An advanced debanding script based on GradFun2DB.

Filters: GradFun2DBmod

http://avisynth.nl/index.php/GradFun2DBmod




HQDeringmod

Applies deringing by using a smart smoother near edges (where ringing occurs) only.

Filters: HQDeringmod

http://avisynth.nl/index.php/HQDering_mod




InterFrame

A frame interpolation script that makes accurate estimations about the content of frames

Filters: InterFrame

http://avisynth.nl/index.php/InterFrame




Lazy Utilities

A collection of helper and wrapper functions meant to help script authors in handling common operations

Filters: LuStackedNto16, LuPlanarToStacked, LuRGB48YV12ToRGB48Y, LuIsFunction, LuSeparateColumns, LuMergePlanes, LuIsHD, LuConvCSP, Lu8To16, Lu16To8, LuIsEq, LuSubstrAtIdx, LuSubstrCnt, LuReplaceStr, LUIsDefined, LuMerge, LuLut, LuLimitDif, LuBlankClip, LuIsSameRes

https://github.com/AviSynth/avs-scripts




LSFmod

A LimitedSharpenFaster mod with a lot of new features and optimizations.

Filters: LSFmod

http://avisynth.nl/index.php/LSFmod




MAA2Mod

Updated version of the MAA2+ antialising script from AnimeIVTC. MAA2 uses tp7’s SangNom2, which provide a nice speedup for SangNom-based antialiasing. Mod version also includes support for EEDI3 along with a few other new functions.

Filters: MAA2

http://avisynth.nl/index.php/MAA2




mClean

Removes noise whilst retaining as much detail as possible.

Filters: mClean

http://forum.doom9.org/showthread.php?t=174804




MCTemporalDenoise

A motion compensated noise removal script with an accompanying post-processing component.

Filters: MCTemporalDenoise, MCTemporalDenoisePP

http://avisynth.nl/index.php/MCTemporalDenoise




MT Expand Multi

Calls mt_expand or mt_inpand multiple times in order to grow or shrink the mask from the desired width and height.

Filters: mt_expand_multi, mt_inpand_multi

http://avisynth.nl/index.php/Dither




MultiSharpen

A small but useful Sharpening Function

Filters: MultiSharpen




nnedi3 AVSI

nnedi3 is an AviSynth 2.5 plugin, but supports all new planar colorspaces when used with AviSynth 2.6

Filters: nnedi3_resize16

http://avisynth.nl/index.php/nnedi3




nnedi3x AVSI

nnedi3x is an AviSynth 2.5 plugin, but supports all new planar colorspaces when used with AviSynth 2.6

Filters: nnedi3x

http://avisynth.nl/index.php/nnedi3




pSharpen

pSharpen performs two-point sharpening to avoid overshoot.

Filters: pSharpen

http://avisynth.nl/index.php/PSharpen




QTGMC

A very high quality deinterlacer with a range of features for both quality and convenience. These include a simple presets system, extensive noise processing capabilities, support for repair of progressive material, precision source matching, shutter speed simulation, etc. Originally based on TempGaussMC by Dide.

Filters: QTGMC

http://avisynth.nl/index.php/QTGMC




ResizeX

Filters: ResizeX

http://avisynth.nl




SMDegrain

SMDegrain, the Simple MDegrain Mod, is mainly a convenience function for using MVTools.

Filters: SMDegrain

http://avisynth.nl/index.php/SMDegrain




SmoothD2c

Deblocking filter. Rewrite of SmoothD. Faster, better detail preservation, optional chroma deblocking.

Filters: SmoothD2c

http://avisynth.nl/index.php/SmoothD2




TemporalDegrain2

Builds on Temporal Degrain but it is able to clean the noise even further while impoving the sharpness in cases where orignal version had severe drops in visual quality.

Filters: TemporalDegrain2

http://avisynth.nl/index.php/TemporalDegrain2




YFRC

Yushko Frame Rate convertor - doubles the frame rate with strong artifact detection and scene change detection. YFRC uses masks to reduce artifacts in areas where interpolation failed.

Filters: YFRC

http://avisynth.nl/index.php/YFRC




Zs_RF_Shared

Shared Functions and utility.

Filters: Dither_Luma_Rebuild, AvsPlusVersionNumber

https://github.com/realfinder/AVS-Stuff






VapourSynth Plugin


AWarpSharp2

VapourSynth port of AWarpSharp2

Filters: warp.AWarpSharp2

https://github.com/dubhater/vapoursynth-awarpsharp2




BM3D

BM3D denoising filter for VapourSynth

Filters: bm3d.RGB2OPP, bm3d.OPP2RGB, bm3d.Basic, bm3d.Final, bm3d.VBasic, bm3d.VFinal, bm3d.VAggregate

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-BM3D




Bwdif

Motion adaptive deinterlacing based on yadif with the use of w3fdif and cubic interpolation algorithms.

Filters: bwdif.Bwdif

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-Bwdif




CAS

Contrast Adaptive Sharpening.

Filters: cas.CAS

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-CAS




CNR2

Cnr2 is a temporal denoiser designed to denoise only the chroma.

Filters: cnr2.Cnr2

https://github.com/dubhater/vapoursynth-cnr2




CTMF

Constant Time Median Filtering.

Filters: ctmf.CTMF

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-CTMF




d2vsource

Source filter to open D2V index files created with DGIndex or D2V Witch.

Filters: d2v.Source

http://github.com/dwbuiten/d2vsource




DCTFilter

Renewed VapourSynth port of DCTFilter.

Filters: dctf.DCTFilter

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-DCTFilter




DCTFilter-f

Renewed VapourSynth port of DCTFilter.

Filters: dctf.DCTFilter

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-DCTFilter




Deblock

Deblocking plugin using the deblocking filter of h264.

Filters: deblock.Deblock

http://github.com/HomeOfVapourSynthEvolution/VapourSynth-Deblock




DeblockPP7

VapourSynth port of pp7 from MPlayer.

Filters: pp7.DeblockPP7

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-DeblockPP7




DegrainMedian

VapourSynth port of DegrainMedian

Filters: dgm.DegrainMedian

https://github.com/dubhater/vapoursynth-degrainmedian




DFTTest

VapourSynth port of dfttest.

Filters: dfttest.DFTTest

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-DFTTest




EEDI2

EEDI2 works by finding the best non-decreasing (non-crossing) warping between two lines by minimizing a cost functional.

Filters: eedi2.EEDI2

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-EEDI2




EEDI3m

EEDI3 works by finding the best non-decreasing (non-crossing) warping between two lines by minimizing a cost functional.

Filters: eedi3m.EEDI3

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-EEDI3




FFT3DFilter

FFT3DFilter uses Fast Fourier Transform method for image processing in frequency domain.

Filters: fft3dfilter.FFT3DFilter

http://github.com/VFR-maniac/VapourSynth-FFT3DFilter




FixTelecinedFades

InsaneAA Anti-Aliasing Script.

Filters: ftf.FixFades

https://github.com/IFeelBloated/Fix-Telecined-Fades




FluxSmooth

FluxSmooth is a filter for smoothing of fluctuations.

Filters: flux.SmoothT, flux.SmoothST

http://github.com/dubhater/vapoursynth-fluxsmooth




fmtconv

Fmtconv is a format-conversion plug-in for the Vapoursynth video processing engine. It does resizing, bitdepth conversion with dithering and colorspace conversion.

Filters: fmtc.bitdepth, fmtc.convert,  core.fmtc.matrix, fmtc.resample, fmtc.transfer, fmtc.primaries,  core.fmtc.matrix2020cl, fmtc.stack16tonative, nativetostack16

http://github.com/EleonoreMizo/fmtconv




HQDN3D

Avisynth port of hqdn3d from avisynth/mplayer.

Filters: hqdn3d.Hqdn3d

https://github.com/Hinterwaeldlers/vapoursynth-hqdn3d




IT

VapourSynth Plugin - Inverse Telecine (YV12 Only, IT-0051 base, IT_YV12-0103 base).

Filters: it.IT

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-IT




msmoosh

MSmooth is a spatial smoother that doesn’t touch edges.
MSharpen is a sharpener that tries to sharpen only edges.

Filters: msmoosh.MSmooth, msmoosh.MSharpen

http://github.com/dubhater/vapoursynth-msmoosh




mvtools

MVTools is a set of filters for motion estimation and compensation.

Filters: mv.Super, mv.Analyse, mv.Recalculate, mv.Compensate, mv.Degrain1, mv.Degrain2, mv.Degrain3, mv.Mask, mv.Finest, mv.Flow, mv.FlowBlur, mv.FlowInter, mv.FlowFPS, mv.BlockFPS, mv.SCDetection, mv.DepanAnalyse, mv.DepanEstimate, mv.DepanCompensate, mv.DepanStabilise

http://github.com/dubhater/vapoursynth-mvtools




mvtools-sf

MVTools is a set of filters for motion estimation and compensation.

Filters: mvsf.Super, mvsf.Analyse, mvsf.Recalculate, mvsf.Compensate, mvsf.Degrain1, mvsf.Degrain2, mvsf.Degrain3, mvsf.Mask, mvsf.Finest, mvsf.Flow, mvsf.FlowBlur, mvsf.FlowInter, mvsf.FlowFPS, mvsf.BlockFPS, mvsf.SCDetection, mvsf.DepanAnalyse, mvsf.DepanEstimate, mvsf.DepanCompensate, mvsf.DepanStabilise

http://github.com/dubhater/vapoursynth-mvtools




nnedi3

nnedi3 is an intra-field only deinterlacer. It takes in a frame, throws away one field, and then interpolates the missing pixels using only information from the kept field.

Filters: nnedi3.nnedi3

http://github.com/dubhater/vapoursynth-nnedi3




nnedi3cl

nnedi3 is an intra-field only deinterlacer. It takes a frame, throws away one field, and then interpolates the missing pixels using only information from the remaining field. It is also good for enlarging images by powers of two.

Filters: nnedi3cl.NNEDI3CL

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-NNEDI3CL




Sangnom

SangNom is a single field deinterlacer using edge-directed interpolation but nowadays it’s mainly used in anti-aliasing scripts.

Filters: sangnom.SangNom

https://bitbucket.org/James1201/vapoursynth-sangnom/overview




scenechange

Filters: scenechange




SVPFlow 1

Motion vectors search plugin  is a deeply refactored and modified version of MVTools2 Avisynth plugin

Filters: svp1.Super, svp1.Analyse, svp1.Convert

https://www.svp-team.com/wiki/Manual:SVPflow




SVPFlow 2

Motion vectors search plugin is a deeply refactored and modified version of MVTools2 Avisynth plugin

Filters: svp2.SmoothFps

https://www.svp-team.com/wiki/Manual:SVPflow




TCanny

Builds an edge map using canny edge detection.

Filters: tcanny.TCanny

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-TCanny




TDeintMod

TDeintMod is a combination of TDeint and TMM, which are both ported from tritical’s AviSynth plugin.

Filters: tdm.TDeintMod

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-TDeintMod




TemporalMedian

TemporalMedian is a temporal denoising filter. It replaces every pixel with the median of its temporal neighbourhood.

Filters: tmedian.TemporalMedian

https://github.com/dubhater/vapoursynth-temporalmedian




temporalsoften

Filters: TemporalSoften




TimeCube

Allows Usage of 3DLuts.

Filters: timecube.Cube

https://github.com/sekrit-twc/timecube




TTempSmooth

VapourSynth port of TTempSmooth.

Filters: ttmpsm.TTempSmooth

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-TTempSmooth




VagueDenoiser

VapourSynth port of VagueDenoiser.

Filters: vd.VagueDenoiser

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-VagueDenoiser




vcfreq

vcvcfreq plugin for VapourSynth.

Filters: vcfreq.F1Quiver, vcfreq.F2Quiver, vcfreq.Blur, vcfreq.Sharp

http://www.avisynth.nl/users/vcmohan/vcfreq/vcfreq.html




vcmod

vcmod plugin for VapourSynth.

Filters: vcmod.Median, vcmod.Variance, vcmod.Amplitude, vcmod.GBlur, vcmod.MBlur, vcmod.Histogram, vcmod.Fan, vcmod.Variance, vcmod.Neural, vcmod.Veed, vcmod.SaltPepper

http://www.avisynth.nl/users/vcmohan/vcmod/vcmod.html




vcmove

vcmove plugin for VapourSynth.

Filters: vcmove.Rotate, vcmove.DeBarrel, vcmove.Quad2Rect, vcmove.Rect2Quad

http://www.avisynth.nl/users/vcmohan/vcmove/vcmove.html




W3FDIF

Weston 3 Field Deinterlacing Filter. Ported from FFmpeg’s libavfilter.

Filters: w3fdif.W3FDIF

https://github.com/HomeOfVapourSynthEvolution/VapourSynth-W3FDIF/releases




Yadifmod

Modified version of Fizick’s avisynth filter port of yadif from mplayer. This version doesn’t internally generate spatial predictions, but takes them from an external clip.

Filters: yadifmod.Yadifmod

http://github.com/HomeOfVapourSynthEvolution/VapourSynth-Yadifmod




znedi3

znedi3 is a CPU-optimized version of nnedi.

Filters: znedi3.nnedi3

https://github.com/sekrit-twc/znedi3






VapourSynth Script


adjust

very basic port of the built-in Avisynth filter Tweak.

Filters: adjust.Tweak

http://github.com/dubhater/vapoursynth-adjust




Dither

VapourSynth port of DitherTools

Filters: Dither.sigmoid_direct, Dither.sigmoid_inverse, Dither.linear_to_gamma, Dither.gamma_to_linear, Dither.clamp16, Dither.sbr16, Dither.Resize16nr, Dither.get_msb, Dither.get_lsb

https://github.com/IFeelBloated/VaporSynth-Functions




finesharp

Port of Didie’s FineSharp script to VapourSynth.

Filters: finesharp.sharpen

http://forum.doom9.org/showthread.php?p=1777860#post1777860




fvsfunc

Small collection of VapourSynth functions

Filters: fvsfunc.GradFun3mod, fvsfunc.DescaleM, fvsfunc.Downscale444, fvsfunc.JIVTC, fvsfunc.OverlayInter, fvsfunc.AutoDeblock, fvsfunc.ReplaceFrames, fvsfunc.maa, fvsfunc.TemporalDegrain, fvsfunc.DescaleAA, fvsfunc.InsertSign

https://github.com/Irrational-Encoding-Wizardry/fvsfunc




G41Fun

The replaced script for hnwvsfunc with re-written functions.

Filters: G41Fun.mClean, G41Fun.NonlinUSM, G41Fun.DetailSharpen, G41Fun.LUSM, G41Fun.JohnFPS, G41Fun.TemporalDegrain2, G41Fun.MCDegrainSharp, G41Fun.FineSharp, G41Fun.psharpen, G41Fun.QTGMC, G41Fun.SMDegrain, G41Fun.daamod, G41Fun.STPressoHD, G41Fun.MLDegrain, G41Fun.Hysteria, G41Fun.SuperToon, G41Fun.EdgeDetect, G41Fun.SpotLess, G41Fun.HQDeringmod, G41Fun.LSFmod, G41Fun.SeeSaw, G41Fun.MaskedDHA

https://github.com/Helenerineium/hnwvsfunc




havsfunc

Various popular AviSynth scripts ported To VapourSynth.

Filters: havsfunc.aaf, havsfunc.AverageFrames, havsfunc.Bob, havsfunc.ChangeFPS, havsfunc.Clamp, havsfunc.ContraSharpening, havsfunc.daa, havsfunc.Deblock_QED, havsfunc.DeHalo_alpha, havsfunc.DitherLumaRebuild, havsfunc.EdgeCleaner, havsfunc.FastLineDarkenMOD, havsfunc.FineDehalo, havsfunc.FixChromaBleedingMod, havsfunc.GrainFactory3, havsfunc.GrainStabilizeMC, havsfunc.HQDeringmod, havsfunc.InterFrame, havsfunc.ivtc_txt60mc, havsfunc.KNLMeansCL, havsfunc.logoNR, havsfunc.LSFmod, havsfunc.LUTDeCrawl, havsfunc.LUTDeRainbow, havsfunc.MCTemporalDenoise, havsfunc.MinBlur, havsfunc.mt_deflate_multi, havsfunc.mt_expand_multi, havsfunc.mt_inflate_multi, havsfunc.mt_inpand_multi, havsfunc.Overlay, havsfunc.Padding, havsfunc.QTGMC, havsfunc.Resize, havsfunc.santiag, havsfunc.sbr, havsfunc.SCDetect, havsfunc.SigmoidDirect, havsfunc.SigmoidInverse, havsfunc.smartfademod, havsfunc.SMDegrain, havsfunc.SmoothLevels, havsfunc.srestore, havsfunc.Stab, havsfunc.STPresso, havsfunc.TemporalDegrain, havsfunc.Toon, havsfunc.Vinverse, havsfunc.Vinverse2, havsfunc.Weave, havsfunc.YAHR

http://github.com/HomeOfVapourSynthEvolution/havsfunc




mcdegrainsharp

TemporalMedian is a temporal denoising filter. It replaces every pixel with the median of its temporal neighbourhood.

Filters: mcdegrainsharp.mcdegrainsharp

https://gist.github.com/4re/b5399b1801072458fc80#file-mcdegrainsharp-py




muvsfunc

Muonium’s VapourSynth functions.

Filters: muvsfunc.LDMerge, muvsfunc.Compare, muvsfunc.ExInpand, muvsfunc.InDeflate, muvsfunc.MultiRemoveGrain, muvsfunc.GradFun3, muvsfunc.AnimeMask, muvsfunc.PolygonExInpand, muvsfunc.Luma, muvsfunc.ediaa, muvsfunc.nnedi3aa, muvsfunc.maa, muvsfunc.SharpAAMcmod, muvsfunc.TEdge, muvsfunc.Sort, muvsfunc.Soothe_mod, muvsfunc.TemporalSoften, muvsfunc.FixTelecinedFades, muvsfunc.TCannyHelper, muvsfunc.MergeChroma, muvsfunc.firniture, muvsfunc.BoxFilter, muvsfunc.SmoothGrad, muvsfunc.DeFilter, muvsfunc.scale, muvsfunc.ColorBarsHD, muvsfunc.SeeSaw, muvsfunc.abcxyz, muvsfunc.Sharpen, muvsfunc.Blur, muvsfunc.BlindDeHalo3, muvsfunc.dfttestMC, muvsfunc.TurnLeft, muvsfunc.TurnRight, muvsfunc.BalanceBorders, muvsfunc.DisplayHistogram, muvsfunc.GuidedFilter, muvsfunc.GMSD, muvsfunc.SSIM, muvsfunc.SSIM_downsample, muvsfunc.LocalStatisticsMatching, muvsfunc.LocalStatistics, muvsfunc.TextSub16, muvsfunc.TMinBlur, muvsfunc.mdering, muvsfunc.BMAFilter, muvsfunc.LLSURE, muvsfunc.YAHRmod, muvsfunc.RandomInterleave

https://github.com/WolframRhodium/muvsfunc




mvmulti

MVTools is a set of filters for motion estimation and compensation.

Filters: mvmulti.StoreVect, mvmulti.Analyse, mvmulti.Recalculate, mvmulti.Compensate, mvmulti.Restore, mvmulti.Flow, mvmulti.DegrainN

http://github.com/dubhater/vapoursynth-mvtools




mvsfunc

mawen1250’s VapourSynth functions.

Filters: mvsfunc.Depth, mvsfunc.ToRGB, mvsfunc.ToYUV, mvsfunc.BM3D, mvsfunc.VFRSplice, mvsfunc.PlaneStatistics, mvsfunc.PlaneCompare, mvsfunc.ShowAverage, mvsfunc.FilterIf, mvsfunc.FilterCombed, mvsfunc.Min, mvsfunc.Max, mvsfunc.Avg, mvsfunc.MinFilter, mvsfunc.MaxFilter, mvsfunc.LimitFilter, mvsfunc.PointPower, mvsfunc.CheckMatrix, mvsfunc.postfix2infix, mvsfunc.SetColorSpace, mvsfunc.AssumeFrame, mvsfunc.AssumeTFF, mvsfunc.AssumeBFF, mvsfunc.AssumeField, mvsfunc.AssumeCombed, mvsfunc.CheckVersion, mvsfunc.GetMatrix, mvsfunc.zDepth, mvsfunc.GetPlane, mvsfunc.PlaneAverage, mvsfunc.Preview, mvsfunc.GrayScale

http://github.com/HomeOfVapourSynthEvolution/mvsfunc




nnedi3_rpow2

nnedi3_rpow2 ported from Avisynth for VapourSynth

Filters: nnedi3_rpow2

https://github.com/Irrational-Encoding-Wizardry/fvsfunc




Oyster

Oyster is an experimental implement of the Blocking Matching concept, designed specifically for compression artifacts removal.

Filters: Oyster.Basic, Oyster.Deringing, Oyster.Destaircase, Oyster.Deblocking, Oyster.Super

https://github.com/IFeelBloated/Oyster




Plum

Plum is a sharpening/blind deconvolution suite with certain advanced features like Non-Local error, Block Matching, etc..

Filters: Plum.Super, Plum.Basic, Plum.Final

https://github.com/IFeelBloated/Plum




psharpen

VapourSynth port of pSharpen

Filters: psharpen.psharpen




resamplehq

TemporalMedian is a temporal denoising filter. It replaces every pixel with the median of its temporal neighbourhood.

Filters: resamplehq.resamplehq

https://gist.github.com/4re/b5399b1801072458fc80#file-mcdegrainsharp-py




taa

A ported AA-script from Avisynth.

Filters: taa.TAAmbk, taa.vsTAAmbk

https://github.com/HomeOfVapourSynthEvolution/vsTAAmbk




Vine

Plum is a sharpening/blind deconvolution suite with certain advanced features like Non-Local error, Block Matching, etc..

Filters: Vine.Super, Vine.Basic, Vine.Final, Vine.Dilation, Vine.Erosion, Vine.Closing, Vine.Opening, Vine.Gradient, Vine.TopHat, Vine.Blackhat

https://github.com/IFeelBloated/Plum
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        	command line option, [1]


      


      	
    LoadSourceFile

      
        	command line option, [1]


      


  

  	
      	
    LoadTemplate

      
        	command line option, [1]


      


  





O


  	
      	
    OpenHelpTopic

      
        	command line option, [1]


      


  





P


  	
      	
    PlaySound

      
        	command line option, [1]


      


  





R


  	
      	
    ResetSettings

      
        	command line option, [1]


      


  





S


  	
      	
    SaveGIF

      
        	command line option, [1]


      


      	
    SaveMKVHDR

      
        	command line option, [1]


      


      	
    SaveMTN

      
        	command line option, [1]


      


      	
    SavePNG

      
        	command line option, [1]


      


      	
    SaveProject

      
        	command line option, [1]


      


      	
    SaveProjectAs

      
        	command line option, [1]


      


      	
    SaveProjectAsTemplate

      
        	command line option, [1]


      


      	
    SaveProjectPath

      
        	command line option, [1]


      


      	
    SetBitrate

      
        	command line option, [1]


      


      	
    SetFilter

      
        	command line option, [1]


      


      	
    SetHideDialogsOption

      
        	command line option, [1]


      


      	
    SetPercent

      
        	command line option, [1]


      


      	
    SetSize

      
        	command line option, [1]


      


      	
    SetTargetFile

      
        	command line option, [1]


      


      	
    SetTargetImageSize

      
        	command line option, [1]


      


      	
    SetTargetImageSizeByPixel

      
        	command line option, [1]


      


      	
    ShowAppsDialog

      
        	command line option, [1]


      


      	
    ShowAudioProfilesDialog

      
        	command line option, [1]


      


      	
    ShowBatchGenerateThumbnailsDialog

      
        	command line option, [1]


      


      	
    ShowCodePreview

      
        	command line option, [1]


      


      	
    ShowCropDialog

      
        	command line option, [1]


      


      	
    ShowDemuxTool

      
        	command line option, [1]


      


      	
    ShowEncoderProfilesDialog

      
        	command line option, [1]


      


      	
    ShowEventCommandsDialog

      
        	command line option, [1]


      


      	
    ShowFileBrowserToOpenProject

      
        	command line option, [1]


      


      	
    ShowFilterProfilesDialog

      
        	command line option, [1]


      


      	
    ShowFiltersEditor

      
        	command line option, [1]


      


      	
    ShowFilterSetupProfilesDialog

      
        	command line option, [1]


      


      	
    ShowHardcodedSubtitleDialog

      
        	command line option, [1]


      


  

  	
      	
    ShowJobsDialog

      
        	command line option, [1]


      


      	
    ShowLogFile

      
        	command line option, [1]


      


      	
    ShowMacrosDialog

      
        	command line option, [1]


      


      	
    ShowMainMenuEditor

      
        	command line option, [1]


      


      	
    ShowMediaInfo

      
        	command line option, [1]


      


      	
    ShowMediaInfoBrowse

      
        	command line option, [1]


      


      	
    ShowMediaInfoFolderViewDialog

      
        	command line option, [1]


      


      	
    ShowMessageBox

      
        	command line option, [1]


      


      	
    ShowMkvInfo

      
        	command line option, [1]


      


      	
    ShowMuxerProfilesDialog

      
        	command line option, [1]


      


      	
    ShowOpenSourceBatchFilesDialog

      
        	command line option, [1]


      


      	
    ShowOpenSourceBlurayFolderDialog

      
        	command line option, [1]


      


      	
    ShowOpenSourceDialog

      
        	command line option, [1]


      


      	
    ShowOpenSourceMergeFilesDialog

      
        	command line option, [1]


      


      	
    ShowOpenSourceSingleFileDialog

      
        	command line option, [1]


      


      	
    ShowOptionsDialog

      
        	command line option, [1]


      


      	
    ShowPreview

      
        	command line option, [1]


      


      	
    ShowScriptInfo

      
        	command line option, [1]


      


      	
    ShowSettingsDialog

      
        	command line option, [1]


      


      	
    ShowSizeMenuEditor

      
        	command line option, [1]


      


      	
    ShowVideoComparison

      
        	command line option, [1]


      


      	
    Shutdown

      
        	command line option, [1]


      


      	
    Standby

      
        	command line option, [1]


      


      	
    StartAutoCrop

      
        	command line option, [1]


      


      	
    StartCompCheck

      
        	command line option, [1]


      


      	
    StartEncoding

      
        	command line option, [1]


      


      	
    StartJobs

      
        	command line option, [1]


      


      	
    StartSmartCrop

      
        	command line option, [1]


      


      	
    StartTool

      
        	command line option, [1]


      


  





T


  	
      	
    TestAndDynamicFileCreation

      
        	command line option, [1]


      


  





W


  	
      	
    WriteLog

      
        	command line option, [1]


      


  







          

      

      

    

  

    
      
          
            
  
	
AddBatchJob

	Adds a batch job.







	sourcefile <string>







	
AddFilter

	Adds a filter at the end of the script.







	active <boolean>



	name <string>



	category <string>



	script <string>







	
AddJob

	Adds a job to the job list.







	showConfirmation <boolean>

	Show Confirmation



	templateName <string>

	Template Name: Name of the template to be loaded after the job was added. Empty to load no template.



	position <integer>

	Position to insert new job







	
AddTags

	Adds tags to the container (works only with mkvmerge).







	tags <string>

	name 1 = value 1; name 2 = value 2; etc.







	
CheckForUpdate

	Checks if a update is available.






	
ClearJobs

	Clears the job list.






	
CopyToClipboard

	Copies a string to the clipboard.







	value <string>

	Copies text to the clipboard. May contain macros.







	
DeleteFiles

	Deletes files in a given directory.







	dir <string>

	Directory: Directory in which to delete files.



	filter <string>

	Example: ‘.txt .log’







	
DynamicMenuItem

	Placeholder for dynamically updated menu items.







	id <dynamicmenuitemid>

	Audio1Profiles, Audio2Profiles, EncoderProfiles, FilterSetupProfiles, MuxerProfiles, RecentProjects, TemplateProjects, HelpApplications, Scripts, AddFilters, InsertFilters, ReplaceFilters, FilterCategory







	
ExecuteCommandLine

	Executes a command line. If Shell Execute is disabled then macros are passed in as environment variables.







	commandLine <string>

	Command Line: The command line to be executed. Macros are solved.



	waitForExit <boolean>

	Wait For Exit: Halt until the command line returns.



	showProcessWindow <boolean>

	Show Process Window: Redirects the output of console apps to StaxRips process window. Disables Shell Execute.



	useShellExecute <boolean>

	Use Shell Execute: Executes the command line using the shell. Available when the Show Process Window option is disabled.



	workingDirectory <string>

	Working Directory: Working directory the process will use.







	
ExecutePowerShellScript

	Executes PowerShell script code.







	code <string>

	Script Code: PowerShell script code to be executed. Macros are expanded.



	externalShell <boolean>

	Use External Shell: Execute in StaxRip to automate StaxRip or use external shell.







	
ExecuteScriptFile

	Executes a PowerShell PS1 script file.







	filepath <string>

	File Path: Filepath to a PowerShell PS1 script file. May contain macros.







	
Exit

	Exits StaxRip






	
GenerateWikiPages

	Generates various wiki pages.






	
ImportVideoEncoderCommandLine

	Changes video encoder settings.







	commandLine <string>

	Command Line







	
LoadProfile

	Loads a audio or video profile.







	videoProfile <string>

	Video



	audioProfile1 <string>

	Audio 1



	audioProfile2 <string>

	Audio 2







	
LoadSourceFile

	Loads a source file.







	path <string>

	Source File Path







	
LoadTemplate

	Loads a template.







	name <string>







	
OpenHelpTopic

	Opens a given help topic In the help browser.







	topic <string>

	Help Topic: Name Of the help topic To be opened.







	
PlaySound

	Plays audio file.







	FilePath <string>

	Filepath to a mp3, wav or wmv sound file.



	Volume <integer>

	Volume (%)







	
ResetSettings

	Shows a dialog allowing to reset specific settings.






	
SaveGIF

	Shows a Open File dialog to generate a short GIF.






	
SaveMKVHDR

	Shows a Open File dialog to add the remaining HDR10 Metadata to a MKV file.






	
SaveMTN

	Shows a Open File dialog to generate thumbnails using mtn engine






	
SavePNG

	Shows a open file dialog to create a high quality PNG animation.






	
SaveProject

	Saves the current project.






	
SaveProjectAs

	Saves the current project.






	
SaveProjectAsTemplate

	Saves the current project as template.






	
SaveProjectPath

	Saves the current project at the specified path.







	path <string>

	The path may contain macros.







	
SetBitrate

	Sets the target video bitrate in Kbps.







	bitrate <integer>

	Target Video Bitrate







	
SetFilter

	Sets a filter replacing a existing filter of same category.







	name <string>



	category <string>



	script <string>







	
SetHideDialogsOption

	Sets the project option ‘Hide dialogs asking to demux, source filter etc.’







	hide <boolean>







	
SetPercent

	Sets the bitrate according to the compressibility.







	value <integer>

	Percent Value







	
SetSize

	Sets the target file size in MB.







	targetSize <integer>

	Target File Size







	
SetTargetFile

	Sets the file path of the target file.







	path <string>

	Target File Path







	
SetTargetImageSize

	Sets the target image size.







	width <integer>



	height <integer>







	
SetTargetImageSizeByPixel

	Sets the target image size by pixels (width x height).







	pixel <integer>







	
ShowAppsDialog

	Dialog to manage external tools.






	
ShowAudioProfilesDialog

	Dialog to manage audio profiles.







	number <integer>

	Track Number (0 or 1)







	
ShowBatchGenerateThumbnailsDialog

	Shows a dialog to generate thumbnails.






	
ShowCodePreview

	Dialog to preview script code.






	
ShowCropDialog

	Shows the crop dialog to crop borders.






	
ShowDemuxTool

	Allows to use StaxRip’s demuxing GUIs independently.






	
ShowEncoderProfilesDialog

	Shows a dialog to manage video encoder profiles.






	
ShowEventCommandsDialog

	Shows the Event Command dialog.






	
ShowFileBrowserToOpenProject

	Shows a file browser to open a project file.






	
ShowFilterProfilesDialog

	Dialog to configure filter profiles.






	
ShowFiltersEditor

	Dialog to edit filters.






	
ShowFilterSetupProfilesDialog

	Dialog to configure filter setup profiles.






	
ShowHardcodedSubtitleDialog

	Shows a dialog to add a hardcoded subtitle.






	
ShowJobsDialog

	Dialog to manage batch jobs.






	
ShowLogFile

	Shows the log file with the built-in log file viewer.






	
ShowMacrosDialog

	Dialog that shows available macros.






	
ShowMainMenuEditor

	Dialog to configure the main menu.






	
ShowMediaInfo

	Shows media info on a given file.







	filepath <string>

	May contain macros.







	
ShowMediaInfoBrowse

	Shows a Open File dialog to show media info.






	
ShowMediaInfoFolderViewDialog

	Presents MediaInfo of all files in a folder in a grid view.






	
ShowMessageBox

	Shows a message box.







	mainInstruction <string>

	Main Instruction: Main instruction may contain macros.



	content <string>

	May contain macros.



	icon <msgicon>

	None, Error, Question, Warning, Info







	
ShowMkvInfo

	Shows a Open File dialog to open a file to be shown by the console tool mkvinfo.






	
ShowMuxerProfilesDialog

	Dialog to manage Muxer profiles.






	
ShowOpenSourceBatchFilesDialog

	Dialog to open a file batch source.






	
ShowOpenSourceBlurayFolderDialog

	Dialog to open a Blu-ray folder source.






	
ShowOpenSourceDialog

	Dialog to open source files.






	
ShowOpenSourceMergeFilesDialog

	Dialog to open a merged files source.






	
ShowOpenSourceSingleFileDialog

	Dialog to open a single file source.






	
ShowOptionsDialog

	Dialog to configure project options.






	
ShowPreview

	Dialog to preview or cut the video.






	
ShowScriptInfo

	Shows script info using various console tools.






	
ShowSettingsDialog

	Shows the settings dialog.






	
ShowSizeMenuEditor

	Menu editor for the size menu.






	
ShowVideoComparison

	Shows a dialog to compare different videos.






	
Shutdown

	Shut down PC.






	
Standby

	Standby PC.






	
StartAutoCrop

	Crops borders automatically.






	
StartCompCheck

	Starts the compressibility check.






	
StartEncoding

	Creates a job and runs the job list.






	
StartJobs

	Runs all active jobs of the job list.






	
StartSmartCrop

	Crops borders automatically until the proper aspect ratio is found.






	
StartTool

	Starts a tool by name as shown in the app manage dialog.







	name <string>

	Tool Name: Tool name as shown in the app manage dialog.







	
TestAndDynamicFileCreation

	Development tests and creation of doc files.






	
WriteLog

	Writes a log message to the log file.







	header <string>

	Header is optional and may contain macros.



	message <string>

	Message is optional and may contain macros.








          

      

      

    

  

    
      
          
            
  

	Name

	Description





	%app:name%

	Returns the path of a given tool, it can be any type of tool found in the Apps dialog. Example: %app:x265%



	%app_dir:name%

	Returns the directory of a given tool, it can be any type of tool found in the Apps dialog. Example: %app_dir:x265%



	%app_path:name%

	Returns the path of a given tool, it can be any type of tool found in the Apps dialog. Example: %app:x265%



	%app_version:name%

	Returns the version of a given tool, it can be any type of tool found in the Apps dialog. Example: %version:x265%



	%audio_bitrate%

	Overall audio bitrate.



	%audio_file1%

	File path of the first audio file.



	%audio_file2%

	File path of the second audio file.



	%compressibility%

	Compressibility value.



	%crop_bottom%

	Bottom crop value.



	%crop_height%

	Crop height.



	%crop_left%

	Left crop value.



	%crop_right%

	Right crop value.



	%crop_top%

	Top crop value.



	%crop_width%

	Crop width.



	%delay%

	Audio delay of the first audio track.



	%delay2%

	Audio delay of the second audio track.



	%dpi%

	DPI value of the main dialog.



	%encoder_ext%

	File extension of the format the encoder of the active project outputs.



	%encoder_out_file%

	Output file of the video encoder.



	%eval:expression%

	Evaluates a PowerShell expression which may contain macros.



	%filter:name%

	Returns the script code of a filter of the active project that matches the specified name.



	%media_info_audio:property%

	Returns a MediaInfo audio property for the video source file.



	%media_info_video:property%

	Returns a MediaInfo video property for the source file.



	%muxer_ext%

	Output extension of the active muxer.



	%player%

	Path of the media player.



	%plugin_dir%

	AviSynth/VapourSynth plugin auto load directory.



	%pos_frame%

	Current preview position in frames.



	%pos_ms%

	Current preview position in milliseconds.



	%processing%

	Returns ‘True’ if a job is currently processing otherwise ‘False’.



	%programs_dir%

	Programs system directory.



	%script_dir%

	Users PowerShell scripts directory.



	%script_ext%

	File extension of the AviSynth/VapourSynth script so either avs or vpy.



	%script_file%

	Path of the AviSynth/VapourSynth script.



	%sel_end%

	End position of the first selecion in the preview.



	%sel_start%

	Start position of the first selecion in the preview.



	%settings_dir%

	Path of the settings direcory.



	%source_dar%

	Source display aspect ratio.



	%source_dir%

	Directory of the source file.



	%source_dir_name%

	Name of the source file directory.



	%source_dir_parent%

	Parent directory of the source file directory.



	%source_ext%

	File extension of the source file.



	%source_file%

	File path of the source video.



	%source_files%

	Source files in quotes separated by a blank.



	%source_files_comma%

	Source files in quotes separated by comma.



	%source_framerate%

	Frame rate returned by the source filter AviSynth section.



	%source_frames%

	Length in frames of the source video.



	%source_height%

	Image height of the source video.



	%source_name%

	The name of the source file without file extension.



	%source_par_x%

	Source pixel/sample aspect ratio.



	%source_par_y%

	Source pixel/sample aspect ratio.



	%source_seconds%

	Length in seconds of the source video.



	%source_temp_file%

	File located in the temp directory using the same name as the source file.



	%source_video_format%

	Video codec of the source file.



	%source_width%

	Image width of the source video.



	%startup_dir%

	Directory of the application.



	%system_dir%

	System directory.



	%target_dar%

	Target display aspect ratio.



	%target_dir%

	Directory of the target file.



	%target_file%

	File path of the target file.



	%target_framerate%

	Frame rate of the target video.



	%target_frames%

	Length in frames of the target video.



	%target_height%

	Image height of the target video.



	%target_name%

	Name of the target file without file extension.



	%target_par_x%

	Target pixel/sample aspect ratio.



	%target_par_y%

	Target pixel/sample aspect ratio.



	%target_seconds%

	Length in seconds of the target video.



	%target_size%

	Size of the target video in kilo bytes.



	%target_temp_file%

	File located in the temp directory using the same name as the target file.



	%target_width%

	Image width of the target video.



	%temp_dir%

	Directory of the source file or the temp directory if enabled.



	%temp_file%

	File located in the temp directory using the same name as the source file.



	%template_name%

	Name of the template the active project is based on.



	%text_editor%

	Path of the application currently associated with TXT files.



	%version%

	StaxRip version.



	%video_bitrate%

	Video bitrate in Kbps



	%video_encoder%

	Name of the active video encoder.



	%video_encoder_settings%

	Settings of the active video encoder.



	%working_dir%

	Directory of the source file or the temp directory if enabled.








          

      

      

    

  

    
      
          
            
  
	
-AddBatchJob:sourcefile

	Adds a batch job.







	sourcefile <string>







	
-AddFilter:active,name,category,script

	Adds a filter at the end of the script.







	active <boolean>



	name <string>



	category <string>



	script <string>







	
-AddJob:showConfirmation,templateName,position

	Adds a job to the job list.







	showConfirmation <boolean>

	Show Confirmation



	templateName <string>

	Template Name: Name of the template to be loaded after the job was added. Empty to load no template.



	position <integer>

	Position to insert new job







	
-AddTags:tags

	Adds tags to the container (works only with mkvmerge).







	tags <string>

	name 1 = value 1; name 2 = value 2; etc.







	
-CheckForUpdate

	Checks if a update is available.






	
-ClearJobs

	Clears the job list.






	
-CopyToClipboard:value

	Copies a string to the clipboard.







	value <string>

	Copies text to the clipboard. May contain macros.







	
-DeleteFiles:dir,filter

	Deletes files in a given directory.







	dir <string>

	Directory: Directory in which to delete files.



	filter <string>

	Example: ‘.txt .log’







	
-DynamicMenuItem:id

	Placeholder for dynamically updated menu items.







	id <dynamicmenuitemid>

	Audio1Profiles, Audio2Profiles, EncoderProfiles, FilterSetupProfiles, MuxerProfiles, RecentProjects, TemplateProjects, HelpApplications, Scripts, AddFilters, InsertFilters, ReplaceFilters, FilterCategory







	
-ExecuteCommandLine:commandLine,waitForExit,showProcessWindow,useShellExecute,workingDirectory

	Executes a command line. If Shell Execute is disabled then macros are passed in as environment variables.







	commandLine <string>

	Command Line: The command line to be executed. Macros are solved.



	waitForExit <boolean>

	Wait For Exit: Halt until the command line returns.



	showProcessWindow <boolean>

	Show Process Window: Redirects the output of console apps to StaxRips process window. Disables Shell Execute.



	useShellExecute <boolean>

	Use Shell Execute: Executes the command line using the shell. Available when the Show Process Window option is disabled.



	workingDirectory <string>

	Working Directory: Working directory the process will use.







	
-ExecutePowerShellScript:code,externalShell

	Executes PowerShell script code.







	code <string>

	Script Code: PowerShell script code to be executed. Macros are expanded.



	externalShell <boolean>

	Use External Shell: Execute in StaxRip to automate StaxRip or use external shell.







	
-ExecuteScriptFile:filepath

	Executes a PowerShell PS1 script file.







	filepath <string>

	File Path: Filepath to a PowerShell PS1 script file. May contain macros.







	
-Exit

	Exits StaxRip






	
-GenerateWikiPages

	Generates various wiki pages.






	
-ImportVideoEncoderCommandLine:commandLine

	Changes video encoder settings.







	commandLine <string>

	Command Line







	
-LoadProfile:videoProfile,audioProfile1,audioProfile2

	Loads a audio or video profile.







	videoProfile <string>

	Video



	audioProfile1 <string>

	Audio 1



	audioProfile2 <string>

	Audio 2







	
-LoadSourceFile:path

	Loads a source file.







	path <string>

	Source File Path







	
-LoadTemplate:name

	Loads a template.







	name <string>







	
-OpenHelpTopic:topic

	Opens a given help topic In the help browser.







	topic <string>

	Help Topic: Name Of the help topic To be opened.







	
-PlaySound:FilePath,Volume

	Plays audio file.







	FilePath <string>

	Filepath to a mp3, wav or wmv sound file.



	Volume <integer>

	Volume (%)







	
-ResetSettings

	Shows a dialog allowing to reset specific settings.






	
-SaveGIF

	Shows a Open File dialog to generate a short GIF.






	
-SaveMKVHDR

	Shows a Open File dialog to add the remaining HDR10 Metadata to a MKV file.






	
-SaveMTN

	Shows a Open File dialog to generate thumbnails using mtn engine






	
-SavePNG

	Shows a open file dialog to create a high quality PNG animation.






	
-SaveProject

	Saves the current project.






	
-SaveProjectAs

	Saves the current project.






	
-SaveProjectAsTemplate

	Saves the current project as template.






	
-SaveProjectPath:path

	Saves the current project at the specified path.







	path <string>

	The path may contain macros.







	
-SetBitrate:bitrate

	Sets the target video bitrate in Kbps.







	bitrate <integer>

	Target Video Bitrate







	
-SetFilter:name,category,script

	Sets a filter replacing a existing filter of same category.







	name <string>



	category <string>



	script <string>







	
-SetHideDialogsOption:hide

	Sets the project option ‘Hide dialogs asking to demux, source filter etc.’







	hide <boolean>







	
-SetPercent:value

	Sets the bitrate according to the compressibility.







	value <integer>

	Percent Value







	
-SetSize:targetSize

	Sets the target file size in MB.







	targetSize <integer>

	Target File Size







	
-SetTargetFile:path

	Sets the file path of the target file.







	path <string>

	Target File Path







	
-SetTargetImageSize:width,height

	Sets the target image size.







	width <integer>



	height <integer>







	
-SetTargetImageSizeByPixel:pixel

	Sets the target image size by pixels (width x height).







	pixel <integer>







	
-ShowAppsDialog

	Dialog to manage external tools.






	
-ShowAudioProfilesDialog:number

	Dialog to manage audio profiles.







	number <integer>

	Track Number (0 or 1)







	
-ShowBatchGenerateThumbnailsDialog

	Shows a dialog to generate thumbnails.






	
-ShowCodePreview

	Dialog to preview script code.






	
-ShowCropDialog

	Shows the crop dialog to crop borders.






	
-ShowDemuxTool

	Allows to use StaxRip’s demuxing GUIs independently.






	
-ShowEncoderProfilesDialog

	Shows a dialog to manage video encoder profiles.






	
-ShowEventCommandsDialog

	Shows the Event Command dialog.






	
-ShowFileBrowserToOpenProject

	Shows a file browser to open a project file.






	
-ShowFilterProfilesDialog

	Dialog to configure filter profiles.






	
-ShowFiltersEditor

	Dialog to edit filters.






	
-ShowFilterSetupProfilesDialog

	Dialog to configure filter setup profiles.






	
-ShowHardcodedSubtitleDialog

	Shows a dialog to add a hardcoded subtitle.






	
-ShowJobsDialog

	Dialog to manage batch jobs.






	
-ShowLogFile

	Shows the log file with the built-in log file viewer.






	
-ShowMacrosDialog

	Dialog that shows available macros.






	
-ShowMainMenuEditor

	Dialog to configure the main menu.






	
-ShowMediaInfo:filepath

	Shows media info on a given file.







	filepath <string>

	May contain macros.







	
-ShowMediaInfoBrowse

	Shows a Open File dialog to show media info.






	
-ShowMediaInfoFolderViewDialog

	Presents MediaInfo of all files in a folder in a grid view.






	
-ShowMessageBox:mainInstruction,content,icon

	Shows a message box.







	mainInstruction <string>

	Main Instruction: Main instruction may contain macros.



	content <string>

	May contain macros.



	icon <msgicon>

	None, Error, Question, Warning, Info







	
-ShowMkvInfo

	Shows a Open File dialog to open a file to be shown by the console tool mkvinfo.






	
-ShowMuxerProfilesDialog

	Dialog to manage Muxer profiles.






	
-ShowOpenSourceBatchFilesDialog

	Dialog to open a file batch source.






	
-ShowOpenSourceBlurayFolderDialog

	Dialog to open a Blu-ray folder source.






	
-ShowOpenSourceDialog

	Dialog to open source files.






	
-ShowOpenSourceMergeFilesDialog

	Dialog to open a merged files source.






	
-ShowOpenSourceSingleFileDialog

	Dialog to open a single file source.






	
-ShowOptionsDialog

	Dialog to configure project options.






	
-ShowPreview

	Dialog to preview or cut the video.






	
-ShowScriptInfo

	Shows script info using various console tools.






	
-ShowSettingsDialog

	Shows the settings dialog.






	
-ShowSizeMenuEditor

	Menu editor for the size menu.






	
-ShowVideoComparison

	Shows a dialog to compare different videos.






	
-Shutdown

	Shut down PC.






	
-Standby

	Standby PC.






	
-StartAutoCrop

	Crops borders automatically.






	
-StartCompCheck

	Starts the compressibility check.






	
-StartEncoding

	Creates a job and runs the job list.






	
-StartJobs

	Runs all active jobs of the job list.






	
-StartSmartCrop

	Crops borders automatically until the proper aspect ratio is found.






	
-StartTool:name

	Starts a tool by name as shown in the app manage dialog.







	name <string>

	Tool Name: Tool name as shown in the app manage dialog.







	
-TestAndDynamicFileCreation

	Development tests and creation of doc files.






	
-WriteLog:header,message

	Writes a log message to the log file.







	header <string>

	Header is optional and may contain macros.



	message <string>

	Message is optional and may contain macros.
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